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WELCOME

Before first usage

hank you for choosing Volume Graphics prod.ucts. This document is

the main manual of myVGL2.0 and contains a reference guide to the

options, menus and dialogs as well as a guide to further resources
such as instructions for (un)installation and maintenance and help/support
options.

All documentation is part of the product, please read it carefully. Make sure
to have the complete documentation available throughout the lifetime of
this product. In case of change of ownership (as far as compliant with the
terms and conditions) make sure to provide the new user with the full
installation package including all supplementary material. Updating your
software installation might include a new documentation version or addi-
tional material. Please make sure to always use matching versions of both
product and supplementary materials.

About this product

myVGlL is a software package for the visualization and documentation of
voxel data projects (.vgl files) created in VGStudio MAX 2.0 or VGStudio 2.0.
It is used in a variety of application areas such as industrial CT, medical
research, life sciences, and many other.

Feature Description

Product myVGL

name

Release 2.0

Scope of Installation package (download or CD-ROM), platform-
delivery specific as ordered, online documentation and supple-

mentary material such as sample data

1 NEREN
TABLE 1-1: PRODUCT DETAILS

The installation instructions will tell you how to install myVGL2.0.

Release 2.0 myVGL Manual 1-1



WELCOME
About this product

Preparations/Warnings

Working with voxel data requires considerable system resources. Shut
down all other applications using large amounts of main memory or pro-
cessor power before launching my¥GlL .

Your work with myV6L might be subject to legal restrictions or company-
specific conditions. Contact your supervisors for details.

Additional information

This manual is part of the documentation of myVGL. Refer to the installation
directory of myVGL to browse the documentation.

Related documents:

If you are looking for... ... refer to:

frr R RRRRRORNRRORRRORORRORORRORERORRORRORRERRRERRRERRRERRRERLEELY

Installation instructions <documents in installation direc-
tory>

Tutorials <documents in installation direc-
tory>

L} 1 o
TABLE 1-2: AVAILABLE DOCUMENTATION

If you are interested in more extensive functionality than the one offered by
myVGL, you have the chance to evaluate our other products, VGStudio 2.0 or
VGStudio MAX 2.0:

www.volumegraphics.com/products/evaluation/form.html
For further questions about our product portfolio, please contact

sales@volumegraphics.com

Conventions used in the documentation

1-2 myVGL Manual

Throughout the documentation, you will find the following conventions:
* Main menus and tools have their own chapter.

» Cross-references like “see chapter...” are linked, click the link to follow
it.

e Menu entries, labels, etc. are highlighted with a sans-serif font and blue color.
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WORKSPACE

he workspace of myVGL2.0 is divided into several workspace win-

dows with which you inspect and manipulate the objects you are

visualizing. Access the tools you need for your tasks from the Icon
bars or the Tooldocks (see Tooldocks on page 2-9 and Icon bars on

page 2-9).

Resize the different workspace windows by moving the mouse cursor over
their respective window borders. The cursor will change to a resize cursor
indicating by its shape the directions in which you can drag it to resize the
workspace window.

Clicking inside a workspace window will mark it as currently selected
workspace window. This is indicated by the blue frame around the selected
workspace window.

Each workspace window is decorated with a set of controls allowing you to
modify the content or the behavior of a workspace window. For an over-
view of the available controls see Table 2-1: Workspace Window Controls

on page 2-1.

Option Icon Description

frr1 N IIRNRRRNRNNORNORORRORORORORORORORORIORORIORINRIRORIRRORORIRORIRIRIRIOLEOLDY
Toggle O Toggle fullscreen state of respective window
fullscreen state

Focus selected ‘0. Focus on selected object

object

Reset zoom 3 Resets zoom of 2D window

Zoom in &  Zoom into 2D window

Zoom out 1 Zoom out of 2D window

tL'OCk slice posi- Locks the slice position.

on

Set brightness Set the Level/Window (aka Brightness/Con-

trast) values for the 2D windows

Original display Select original color mode to display the slice

mode image in its original, brightness and contrast
settings.

Color mode/ Switch between Color mode and Color and Opac-

Color and

HE 8§ @

Opacity mode ity mode.

NE RN
TABLE 2-1: WORKSPACE WINDOW CONTROLS
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Object selection

WORKSPACE

3D Window

Option Icon Description

fTrr1rrrrrrrrININRRRRRNNRRRRRORORRRRORRORRRRNRRRRRRRRRELLDY

Create/replace 4 Create/replace a clipping plane based on the

clipping plane current slice view.

4/2/1 pixels per < Specify the amount of downsampling in the

ray s 3D window.

Freeze render- o Enable/disable the rendering process.

ing

Center and == Centers the selected objects and makes them

Focus camera fully visible.

frr1rr RN LLRRNRRRRNRNRNORORRORORORORIRRORORIRORIRIRIRIRIRRRRIRRIRRERIREILLDY
TABLE 2-1: WORKSPACE WINDOW CONTROLS

3D Window

The 3D window shows the result image of the rendering process. Specify
rendering parameters for voxel data sets with the Volume Rendering tool (see
Volume Rendering tool on page -1). Specify rendering parameters for
polygonal models with the Polygon Rendering tool (see chapter Polvgon Ren-

dering tool).

The coordinate system tripod in the lower left corner of the 3D window indi-
cates the orientation of the currently chosen coordinate system. Select a
coordinate system from the Coordinate system icon bar to change the cur-
rently selected coordinate system.

If you select an object in the Scene Tree (and it is chosen to be visible by
activating the checkbox in front of it), the corners of a box surrounding it
will be shown in the 3D window. Most of these corners will be bright red if
you are in the Rotate mode and bright green if you are in Move mode. The
lines that are not in that respective color represent the x (dark red), y (dark
green) and z (blue) axes of the object’s coordinate system.

Tips and tricks

You can also select an object by double-clicking onto it in the 3D window
with the left mouse button. By holding down <C#r/> while doing so you,
you can select multiple objects. Double-Click the background to deselect
all objects.

Move / Rotate mode

2-2  myVGL Manual

There are two basic modes for the 3D window: The Rotate mode and the
Move mode. Choose a mode by clicking the respective icon in the icon bar

. + , by choosing the respective entry from the Object menu or by
using the <Ctr/>+<Shift>+R / <Ctrl>+<Shift>+M shortcuts.
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WORKSPACE
3D Window

Tips and tricks

You can also switch between the Rotate mode and the Move mode by
double-clicking into the 3D window with the middle mouse button.

MOVE MODE

When in Move mode, drag the selected object by using the left mouse but-
ton. To move the object in smaller steps, hold <Ctr/> while doing so.

Hold down the middle mouse button and move the mouse up or down to
zoom into or out of the scene.

Tips and tricks

If you want to zoom in on a specific point of the object, position the mouse
pointer over it, hold <Ctr/> and rotate the mouse wheel.

Hold down <Shift> in Move mode to move the object along either the
vertical or horizontal direction of the 3D window image plane.

ROTATE MODE

When in the Rotate mode, left-click the selected object, hold it and move
the mouse to rotate the object into the respective direction. To rotate the
object in smaller steps, hold <Ctr/> while doing so.

Hold down the middle mouse button and move the mouse up / down to
rotate the object clockwise / counter-clockwise.

Hold down <Shift> in Rotate mode to rotate the object along either
the vertical or horizontal direction of the 3D window image plane.

An object will always be rotated around its center: see Center in chap-
ter Transform tool on page 14-2.

Warning

An object can only be transformed (i.e. moved/rotated) within the scene if
it is unlocked in the Scene Tree. If it is locked, you will transform the
camera instead. If there is only one object visible, you might not notice a
difference between the two cases, but it becomes important when there are
multiple objects involved, when you perform measurements or when you
are in the Scene coordinate system.

Preview

You can also transform objects through keyboard input: See chapter Trans-
form tool.

The Preview factor is a reduction factor by which the rendering of voxel
data sets is reduced while manipulating a scene. Higher reduction factors
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2 WORKSPACE
Context menu of 3D window

will lead to a smoother interaction. This is especially helpful on computers
with a low overall performance.

41211 pixels per ray
Specify if you want to render every 16th, every 4th or every pixel. The
former option leads to the fastest rendering, the latter to the most accurate.

Freeze rendering
Click this button to stop rendering of your object. This can be useful if you
want to make changes to your data without showing the results in the 3D
window after each step.

Center and focus camera
Click this button to center the currently selected object and make it become
fully visible within the 3D window.

Toggle fullscreen state
Toggle the fullscreen mode of this window.

Tipsandtricks  You can also use the /1 key to toggle the fullscreen mode.

Context menu of 3D window

Right-click anywhere in the 3D window to access its context menu.

Annotations
In this submenu, you can Minimize, Maximize or automatically Arrange anno-
tations. You can also Configure the settings for this.

Freeze rendering
Stops the rendering process.

Tripod/Box > Show tripod
Toggles the display of the coordinate system tripod.

Tripod/Box > Show box
Toggles the display of the grid box of the coordinate system with tick
marks.

Tripod/Box > Configure

Brings up the preference dialog for the coordinate system display.
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WORKSPACE
2D Windows

Clipping > Create clipping plane

Creates a clipping plane, see Clipping plane on page 13-1

Clipping > Create clipping box

Creates a clipping box, see Clipping box on page 13-2

Clipping > Create aligned clipping box
Creates an aligned clipping box, see Aligned clipping box on page 13-2

Text overlay > Default / Preset
Either select the Default text overlay preset or a user defined text overlay
preset.

Text overlay > Configure ...
Shows the Configure text overlay dialog see chapter Text Overlay Editor

Background color
Displays a dialog window in which you can choose whether you want the
background of the 3D window to be a single color, a horizontal or a vertical
gradient and lets you pick the respective color(s).

Reset
Resets all transformations applied to the selected object.

Copy to clipboard
Copy a screenshot of the 3D window to the clipboard.

Properties
Displays information about the selected object. For more information,
please refer to Properties on page 12-4 in chapter Scene Tree tool

2D Windows

The 2D windows show slices of the currently visible objects as seen from
the Front (along the y-axis), Top (along the z-axis), respectively Right (along
the x-axis) of the current coordinate system.

Voxel data is shown in gray values, whereas polygonal models, ROIs and
selections are displayed as colored outlines in the 2D windows.

You can scroll through sections in a certain direction by scrolling the
mouse wheel while the mouse pointer is in the respective window or by
changing the value in the text box in the lower left corner of the 2D win-
dow.
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WORKSPACE
2D Windows

Use the scroll bars below and on the right hand side of each 2D window to
move the content of the window.

Tips and tricks

Using the middle mouse button, you can also drag the slice view around in
the window.

Focus selected object

Reset zoom

Zoom in / out

By clicking this button, you can center the slice view of the selected object
in the 2D window.

Use this button to reset the zoom of the 2D window.

Use these buttons to zoom into or out of the respective 2D window.

Tips and tricks

If you want to zoom in on a specific point of the object, position the mouse
pointer over it, hold <Ctrl> and rotate the mouse wheel.

Lock slice position

Set brightness

Locks the slice position for this 2D window. That means that for example

moving the Navigation cursor will not cause this 2D window to switch to the
respective slice. However, it is possible to modify the slice position delib-

erately by entering a value in slice position spin box.

This feature can be enabled/disabled in the Preferences: see General in
chapter Edit menu on page 4-2

Click this button, if you are in Original display mode or Color mode. The
Level/Window settings are set for a selected object in the 2D view.

A window appears in which you can specify the Level/Window (i.e. Bright-
ness/Contrast) values for the 2D windows.

Click the ( button to reset the Level/Window values for the selected object.
Click the X button to disable Brightness/Contrast rendering completely
(The brightness button is shown crossed-out). Click the Wbutton to accept
the Level/Window values and close the settings window.

Tips and tricks

You can also hold down the left mouse button over a 2D window and move
it vertically to modify the Level values and horizontally for the Window
values.

2-6 myVGL Manual
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WORKSPACE
Context menu of 2D window

Original display mode
Toggle between displaying the slice images in their original brightness,
contrast and color settings and showing them in the settings specified in
Display mode.

Color mode / Color and Opacity mode
Choose which of the user-defined Volume Rendering settings you want the
2D windows to display: only the colors or the colors and the opacity set-

tings.

Create clipping plane
Click this button create a clipping plane aligned to the view represented by
the selected 2D window. Use this to orientate yourself within the 3D win-
dow or to show the interior of the object at the current slice position.

Toggle fullscreen state
Toggle the fullscreen mode of this window.

Tipsandtricks  You can also use the /1 key to do so.

Context menu of 2D window

frrrrrrrrrrrrNILNNNNRNRNRRRNROR NN RRRNO R RRORRRORRRRIRRRRREEOLN
If you right-click anywhere in the 2D window, you can access its context
menu.

Zoom > Zoom in/out
Zooms into or out of the 2D window.

Zoom > Fit object to window
By clicking this button, you can center the slice view of the selected object
in the 2D window.

Zoom > Fit scene to window
By clicking this button, you can center the slice view of the whole scene in
the 2D window.

Zoom > Reset
Resets the zoom settings.

Coordinate system

Here you can specify a reference coordinate system for the respective 2D
window. Other 2D windows will not be affected by this choice. Select Fol-
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Display mode

Slice step width

Level/Window mode

Background

Annotations

Text overlay

WORKSPACE
Context menu of 2D window

low global coordinate system to reference the coordinate system active in the
Coordinate system icon bar.

Choose if you want the display of the 2D windows in original settings,
overlaid with colors defined in the Volume Rendering Tool or overlaid with
both colors and opacity settings defined in the Volume Rendering Tool. See
Display mode on page 9-3 in chapter Window menu.

Here, you can define the step width to be used when scrolling through
slices in the 2D views. It is only active when you are not in a “Grid of ...”
coordinate system.

Here you can toggle the Set Brightness window. For further information
please see Set brightness on page 2-6.

Set the background color of the 2D windows here.

In this submenu, you can Minimize, Maximize or automatically Arrange anno-
tations. You can also Configure the settings for this.

Here you can toggle the display of text information (Show text overlay),
choose from different Text Overlay presets and Configure those presets.

Clipping > Create clipping plane

Interpolation mode

see Create clipping plane on page 2-7

Here you can choose if you want myVGL2.0 to always (On) interpolate
between voxels, never (Off) or decide automatically when to do so.

Tripod overlay > Show tripod

Toggles the display of the coordinate system tripod.

Tripod overlay > Configure

Reset

2-8 myVGL Manual

Shows the preference dialog for the coordinate system display.

Resets all transformations applied to the selected object.
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Copy to clipboard

Properties

WORKSPACE
Tooldocks

Copy a screenshot of the active window to the clipboard.

Displays information about the selected object. For more information,
please refer to Properties in chapter Scene Tree tool on page 12-4.

Tooldocks

The Tooldock, per default on the right hand side of the workspace, is used
to dock tools. You can minimize the tools, close them or have them free
floating over the workspace by clicking the respective icons in their upper
right corner. You can arrange the tools in an arbitrary order by dragging &
dropping non-minimized tools.

You can open further tool docks below or on the left hand side of the work-
space by simply dragging & dropping tools there.

Due to their format, most tools can only be put in vertical tooldocks.

You can resize tooldocks or hide them completely by clicking the border
between them and the workspace and moving them into the desired direc-
tion.

Icon bars

The icon docks are used to dock icon bars. Icon bars consist of one or more
icons that represent shortcuts to functions most of which are otherwise
accessible via the menus. You can distribute icon bars in icon docks. Per
default, there is only one icon dock at the top of the workspace. You can
however open further icon docks below, on the left or right hand side of the
workspace: Simply drag and drop an icon bar there.

By right-clicking an icon dock, you can choose which icon bars should be
visible and which not by checking or unchecking the boxes in front of
them.

Tips and tricks

Once you are done organizing the icon bars, you can right-click the
respective icon docks and choose Line up to align the icon bars without

gaps.
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Icon bars

Display unit
In the icon dock you can find the Display unit toolbar. You can use this to
select the unit in which to display length, area and volume values. Set addi-
tional parameters about units via Edit > Preferences.
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he File menu of myVGL2.0 provides basic features for loading

projects as well as for saving images or image stacks. Thus the File

menu allows you to handle the two basic file types: object files and
project files (and folders).

Object files

These files contain voxel data representing your real object, basically the
output of the CT-scanner (after scanning and reconstruction) or some other
device, or contain other data representing your real object, such as poly-
gons.

The number of files per object varies. You might have orne file containing
the whole object (volume file formats) or an image stack (e.g., bitmaps or
tiffs) where each file represents one slice of the scanned object. Scanner
settings and additional information might be included in the data files or in
separate files.

Project files (and folders)

.vgl files contain basic information on the project including references to
the object files and supplementary files belonging to the project. For sup-
plementary files a project folder will be created as a subdirectory of the
directory in which you saved the .vgl file.

Warning

A .vgl file must always be accompanied by the project folder and the file(s)
containing the object(s). You cannot open a .vgl file without the associated
project folder, and you cannot load an object into the scene without the files
containing the object data.

.vgl files and project folders replace the .vgi files of earlier versions of
myVGL containing the scene.

The project will include references to all imported objects, modifications
such as rotation, opacity settings and analysis results. Items in the Scene
Tree (see chapter Scene Tree tool) like light sources or measurement fea-
tures are saved as well as the layout of the 3D and 2D windows.

A scene can contain one or multiple objects. You can work with only one
project at a time.

See Table 3-1: File menu options for a list of File menu options, to be
described in the following. Menu entries currently not available are dis-
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New

abled and displayed in gray (e.g., saving is only possible after loading a
project or an object).

Option Icon Description
| I I DN D B B IO D B DO RO RO D DN D BN RN NN DN B B RN DN DN D DN BN BN NN BN DN BN RN NN DN BN RN BN DN DN B B BN RN B BN BN BN BN B B )
New _]  Create a new project
Open... ._.F:: Open a complete scene (or a single volume)
Save Save selected views (e.g., slice views) as
image(s)... images
(several format options)
Save AVI/ Save selected visible items of the scene into an
image stack image stack or .avi file
Print image(s)... =1 Print selected views (e.g., slice views) as
images
Quit Ep] Exit the application

EE RN
TABLE 3-1: FILE MENU OPTIONS

New

Choose this option if you want to exit the current project and create a new
empty scene. You would typically proceed by opening a project or a scene.

Open...

Opens a project saved in a .vgl file (or scene saved in a .vgi file). You can
either open the file including the analyses, material settings etc., or load
just a single volume from the file. If you open a .vgl file (or a .vgi file),
make sure the project directory and object file(s) are available as well.

.vgl files are used for projects in my¥GL2.0, but you can also read scenes
from .vgi files which were used by previous versions of my¥GL.

Throughout the entire open process, defaults will be set to the values you
specified in the last process or, where applicable, to information automati-
cally retrieved from the files (such as resolution which is included in some
file formats).

Tips and tricks

During the whole open process, myVGL will scan the data file(s) (e.g., to
provide you with default values and a preview). Copy the files to your local
harddisk to speed up the process as well as to avoid problems caused by
networking or CD/DVD drive lags.
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A sophisticated import wizard will lead you through the open process (see
Open options on page 3-3) of volume data.

If the wizard has gathered enough information about the volume to be
imported, it can display the Memory needed to load the data based on the
specifications so far and the Memory available on your system. If the mem-
ory needed exceeds the memory available, the field will be highlighted in
red. Reduce the amount of data by mapping to a “smaller” data type, by
applying a region of interest or a skip factor.

Warning

Although you can load and display an object if the memory available is
larger than the memory needed, analysis tasks require additional memory.

Open options

These options will be available during the open process and are explained
below (see Open options on page 3-3) in the sections for the respective dia-
logs. The memory values will be updated continuously.

Depending on the file(s) you want to open and the options you specified so
far, the myV¥GL import wizard will show you a series of dialogs. The dialogs
and their options are explained below. Note that you will only see the dia-
logs relevant to your object.

Tips and tricks

After selecting a file , you can see the content of that file in the preview
window on the left hand side of the import wizard.

OPEN PROJECT

This option will open the complete file, including analyses, material set-
tings, reference objects etc.

IMPORT SINGLE VOLUME

This option loads a single volume from the file, either completely or using
a specified region of interest (ROI).

LOAD SCENE

You can apply the Resolution reduction (skip) option to be able to load a very
large object into a low capacity system.

Warning

Applying a skip factor will reduce the resolution of the voxel data and thus
lead to significantly less accurate analysis results.

Specify the number of voxels to be skipped in the respective direction. A
skip rate of 0 applies no skipping. A skip rate of 1 for one axis will load
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only every other slice so that the memory needed is reduced by half. A skip
rate of 5 will skip 5 slices, load one slice, then again skip 5 slices etc.

You can also reduce the memory needed by specifying the analyses you
want to load. The Included analyses list shows all analyses of the project as
well as the memory needed to load them. Deactivate the Load? checkbox
for all analyses you don’t want to load.

FILE SELECTION

Choose the volume you want to open from the list.

LOAD AS...

Several parameters determine how the data shall be loaded. For example,
the type of data loaded can be different from the type stored on disk. The
dialog will show you only the parameters applicable to your data.

Specify the voxel size in the resolution part of the dialog. Some data formats
provide this information automatically. In this case the input field will be
disabled and show the given numbers, you can correct/modify those num-
bers if you activate the Override resolution checkbox.

If the data has significant differences (e.g., factor 3 or more) in voxel size
for x, y, and z, the resulting pictures will show elongated steps in the
respective dimension. In order to improve the visual appearance, you can
activate the Force isotropic resampling checkbox. my¥6L will then interpolate
intermediate slices.

You can import data sets with varying slice distances. If the object has been
scanned with small slice distances but in certain areas only, the resolution
has wide differences. In this case you would probably not want to resample
the data set. Use the option No slice interpolation beyond... . Slice distances
larger than the number specified will not be padded with interpolated
slices.

Warning

Forcing isotropic resampling might change analysis results. Use this option
only if you want to optimize the visual presentation of the data for creating
screenshots, avi files etc.
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Use the Data range mapping area to specify the interval of original gray val-
ues to be imported and the interval they shall be mapped to. This interval
must not exceed the number of gray values of the data type (to be specified
in the same dialog). Voxels with gray values outside the interval will also
be imported, but with assigned gray values inside the interval. The assigned
gray value depends on the mapping specified, see Table 3-3: Gray value

Release 2.0



FILE MENU
Open...

handling on page 3-6. As an alternative, you can specify the intervals in the
histogram.

Click the Histogram button to open another window showing the gray values
and their numbers of occurrences. For details, see Histogram (Import) on

page 3-7.

The Data range mapping determines the range of gray values used for your
object, i.e. it specifies the maximum number of different gray values avail-
able for your object. The size of the data range is always smaller than or
equal to the numbers of gray values in the data type. For details on the data
types, please refer to Table 3-2: Data types.

Data type Description
unsigned 8 bit / 8 bit code one gray value, each bit has either
signed 8 bit value 0 or value 1. Consequently, 2° =256

different gray values are possible
Gray values from 0 to 255 (unsigned)
or -128 to 127 (signed)

unsigned 16 bit / 2'%=65 536 different gray values.
signed 16 bit Gray values from 0 to 65 535 (unsigned)
or -32 768 to 32 767 (signed)

unsigned 32 bit / More than one million different gray values.
signed 32 bit Gray values from 0 to 1 048 575 (unsigned)
or -524 288 to 524 287 (signed)

32 bit float Effective gray value dynamics 32 bit float,
3D rendering as 16 bit

rgb8 8 bit per RGB component color images for a
total of 24bit color.

1 NN
TABLE 3-2: DATA TYPES

Warning

Objects with 32 bit signed/unsigned data have an effective data range of 20
bit for all rendering procedures (full data range for analysis procedures).

Choosing a lower data type (i.e., a data type with a lower number of gray
values) than the type in which your files are available may reduce accuracy
because your object will be described by a lower number of gray values. In
contrast, it is not possible to increase accuracy by selecting a higher data

type.

Tips and tricks

Loading floating data requires a lot of main memory. If your scanner has 32
bit float as output and your system is not capable of dealing with this
amount of data, choose a data type mapping (e.g., 16 bit unsigned).
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Select an option to determine how values outside the interval shall be han-
dled. As a default, gray values below the lower interval limit will be set to
the value of the lower interval limit, gray values higher than the upper
interval limit will be set to the value of the upper interval limit. This is the
option Ramp. The options are listed in Table 3-3: Gray value handling.

Lower gray values Higher gray values
Option Shape will be set to: will be set to:
| I I DN D B B IO D B DO RO RO D DN D BN RN NN DN B B RN DN DN D DN BN BN NN BN DN BN RN NN DN BN RN BN DN DN B B BN RN B BN BN BN BN B B )
Ramp lower interval limit  upper interval limit
Inverse upper interval limit  lower interval limit
Ramp

Inverse
Sawtooth

_/_
_\

Sawtooth A lower interval limit lower interval limit
N

lower interval limit lower interval limit

TABLE 3-3: GRAY VALUE HANDLING

You can use this option to invert the data. If your data has low gray values
for material and high gray values for air so that you would see black mate-
rial and white air, apply the Inverse Ramp to see white material and a black
background.

Click the Preview button for 2D previews of your object. The preview is
also available in the following steps. For details, see Preview (Import) on

page 3-8.

ROI AND SKIP SELECTION

This dialog offers options to reduce the memory needed to load the object.

The scanned object will usually be surrounded by air. Reducing (but not
eliminating) the surrounding air by applying a Region of Interest (ROI)
reduces the memory needed. Only the slices from Min to Max (in x, y, and z
direction) will be imported. Use the Preview for graphically supported ROI
specification (see Preview (Import) on page 3-8 and How to define a ROl

graphically in the preview on page 3-9).

Warning

Do not apply a ROI directly on the object’s surface or even cutting into the
object. This would destroy the partial volume effect and thus cause
imprecise measurement results. Make sure to import the object including
some surrounding air.

3-6 myVGL Manual

If your object is surrounded by a large number of background (air) voxels,
applying a ROI reduces the memory needed very efficiently without nega-
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tive effects on the quality. In other cases you might have to apply the Skip
option to be able to load a very large object into a low capacity system.

Warning

Applying a skip factor will reduce the resolution of the voxel data and thus
lead to significantly less accurate analysis results.

Histogram (Import)

Specify the number of voxels to be skipped in the respective direction. A
skip rate of 0 applies no skipping. A skip rate of 1 for one axis will load
only every other slice so that the memory needed is reduced by half. A skip
rate of 5 will skip 5 slices, load one slice, then again skip 5 slices etc.

MANIPULATION

| IO I D IO NN DN D RO BN RN I D B RN BN DN DN D BN BN BN DN D RO BN RN NN DN DN BN BN BN DN DN BN N RN DN O DN BN B BN NN BN BN BN BN N BN BN )
You can swap or mirror axes in order to display the object in a preferred or
real-world orientation.

Mirror axes will mirror the object along the chosen axis or axes (e.g., activat-
ing the checkbox for the x-axis will place the voxel with the highest value
for x at the origin of the x-axis). You can choose more than one axis to mir-
IOf.

Swap axes will change the axes in the coordinate system so that instead of
Xyz, the coordinates will be interpreted in the chosen sequence (e.g., choos-
ing xzy instead of xyz will keep the position on the x-axis but change the y
coordinate to z and vice versa. The result is a rotation by 90° around the x-
axis followed by a mirroring along the y-axis).

Click the Histogram button in the Load as dialog to open another window.
The Histogram tab displays the number of occurrences of each gray value in
the object as a diagram. The gray values of the object’s voxels are given on
the axis of abscissae. The number of voxels with each gray value are given
on the axis of ordinates. The dark gray area in the background of the dia-
gram shows the number of occurrences of each gray value.

The histogram contains two vertical red lines, initially positioned at the
very left and the very right of the diagram. Each red line is labeled with two
numbers, the first indicating the gray value at the current position of the
line, the second shows how many voxels in the object are of this gray
value.

You can move the red lines by left-clicking them. Shift them left or right
while holding the left mouse button pressed. Shifting a line to a new posi-
tion will adapt the value in the Data range mapping area of the Load as dialog
and vice versa. You can also change the ramp type in the Load as dialog
while the Histogram is displayed.
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Use either of the methods to define an interval of significant gray values,
i.e., the interval in which there is a high probability of gray values varying
in accordance with a variation of the material. A typical histogram has one
peak for each material in the data set plus one peak for the air. Make sure
not to cut out any of those peaks. Always keep the air peak, myVGL needs
surrounding air for the interpretation of the partial volume effect which is
the basis for analysis results.

The Calibration tab allows you to perform a gray value calibration within the
import process. Here you can dynamically select material and background
gray values and assign them to destination gray values. Select either the
Define background button or the Define material button. Move your mouse
cursor over the preview window. Hold down the left mouse button and
move the mouse to create a selection rectangle. The area inside the rectan-
gle is considered for either background or material selection. By pressing
the Apply button the acquired values are applied to the data range mapping
on the Load as dialog.

The Preview button is available in a number of import dialogs. Click this
button for 2D previews and projections of your object in order to:

Control the parameters specified so far
If you only see black and white stripes or a grainy image, check the data
type and/or size specified earlier.

Define a Region of Interest (ROI)

Modify the ROI settings by adapting the blue frame in the slice preview or
one of the projections. For detailed instructions, see How fo define a ROl
graphically in the preview on page 3-9. You can also modify the settings in
the dialog ROI and Skip selection (see ROI and Skip selection on page 3-6).

Click the tabs to select one of the views. The following views are available:

Slice Preview (top/right/front)

The main area of the Preview tab shows a single slice of your object. Spec-
ify the slice number in the lower left input field by using either the number
keys, arrow keys or the mouse.

Choose the axis along which to slice by clicking the buttons:
» Button T for top perspective

» Button R for right perspective

* Button F for front perspective

You can enhance the contrast automatically:
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* Button C for auto contrast

By default, the preview will be rendered taking into account the data range
settings (see Histogram (Import) on page 3-7). Activating auto contrast
will analyze the data set and apply a ramp mapping to the data range cov-
ered by the voxels in the current slice.

Projection preview (top/right/front)

Click the Top projection tab for a projection along the z-axis. All xy-planes
of your object will be projected into one 2D view.

Click the Right projection tab for a projection along the x-axis. All yz-planes
of your object will be projected into one 2D view.

Click the Front projection tab for a projection along the y-axis. All xz-planes
of your object will be projected into one 2D view.

Save image(s)...

Captures your current workspace area into an image. The Views area dis-
plays the currently available workspace windows. By clicking the check-
box beside each entry you can select the window to be taken into account
for the final image. The Preview area shows the screenshot so far.

The Decorations area contains options for displaying additional information
within the screenshot. By choosing the option show logo in headline you can
define a custom logo that will appear above the headline specified inside the

headline text field. By selecting show legend, the current slice position, the

HOW TO DEFINE A ROI GRAPHICALLY IN THE PREVIEW

If the scanned area contains a lot of background, importing
the full data set would result in unnecessarily high memory
consumption. To reduce memory load, define a Region of
Interest (ROI) to be imported.

A ROI defined during import is always a cuboid. The
maximum size for a ROI is the size of the scanned area.

You can define a ROI based on numerical input in a dialog
(see ROI and Skip selection on page 3-6) or
graphically in the preview (see Preview (Import) on
page 3-8). Here, the graphical approach will be
explained.

In any of the four preview tabs (slice preview,
top/right/front projection), use the mouse to resize or move
the blue frame surrounding the scanned area. If the blue

frame is not visible, use the +/- buttons and the scrollbars
to adjust the view.

Resizing Left-click a corner or an edge of the blue
frame surrounding the scanned area and draw the mouse
pointer.

Moving Left-click into the area surrounded by the blue
frame and draw the mouse pointer. You can only move the
frame if the ROI is smaller than the scanned area.

Any modifications are always valid for all slices along the
chosen axis.

The ROI should preferably be controlled in the projection
views to ensure the full extent of the object is visible.
Modifying the ROI in a single slice might accidentally cut
off protruding parts of your object visible only in other
slices.
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Save AVI/image stack ...

current coordinate system and the window type will be attached below the
image for the respective window.

The Overlays area gives you the option to enable/disable graphical overlays
like analyses results, reference objects, the isosurface and measurements.
This does not influence the objects in your scene. Disabling for example
the measurements will only disable them within the screenshot.

Within the Custom image size area you can specify an image size differing
from the suggested one. Image width and height can be coupled to keep a
reasonable aspect ratio for the image. The dpi value controls the size of han-
dles, fonts and other display-relative elements. You can use it to save
images at higher resolutions and still retain the proportions of these ele-
ments.

Tips and tricks

If you select only one window within the Views area, you can change the
image width and height parameters independently from each other by
clicking the lock/unlock button to the right of the width/height input fields.
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Supported formats:

Bitmap (*.bmp)

JPEG (*.jpg)

JPEG2000 (*.jp2)
Portable Pixmap (*.ppm)
Tiff (*.tif)

Save AVl/image stack ...

Saves the slices of one of the 2D views into an AVI movie or an image
stack.

Select the 2D view to specify the orientation. The images will be created
parallel to this view.

Select Display mode to specify the coloring of the resulting image (for
details on display modes see Display mode in chapter Window menu on

page 9-3).

The Overlays area gives you the option of enabling/disabling graphical
overlays like analyses results, reference objects, the isosurface and mea-
surements. This does not influence the objects in your scene. Disabling for
example the measurements will only disable them within the screenshot.

Define the resulting Image size (in pixels). By clicking on the button to the
right of the width/height parameters you can specify whether the image
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size should be scaled uniformly or not. If uniform scaling is activated,
changing the width will change the height of the image in proportion to the
width (and vice versa). A larger image size leads to a better resolution.

The Boundary option allows you to define an additional offset applied to the
original image. It does not change the image size, instead it enables you to
zoom into or out of the current viewport.

The Stack settings specify the number of slices and the slice distance in the
given unit. The stack settings apply to the complete data set in the current
orientation. Modifying the number of slices will recalculate the slice dis-
tance and vice versa:

distance x (number of slices — 1) = height of complete data set

The Slice range parameters specify the part of the slices to be exported. The
slices will be resampled, applying the stack settings such that one of the
slices will be positioned at the start value. The end value specifies the upper
boundary of the slices. The first slice to be exported is defined by the start
value, the second slice is at position (start value + slice distance).

You can also set the start and end values by navigating to the desired posi-
tion in the Preview and clicking the s for start or e for end. If the end slice
has a lower value than the start slice, the values will be swapped.

Modifying the Slice range will change the number of slices but not the slice
distance. The number of slices and distance parameters specify how fine the
data should be sampled within the given Slice range.

Supported formats:

Bitmap (*.bmp)

JPEG (*.jpg)

JPEG2000 (*.jp2)
Portable Pixmap (*.ppm)
Tiff (*.tif)

AVI movie (*.avi)

Print image(s)...

Send a snapshot of the current workspace for documentation purposes to a
printer. Select the 2D/3D views to be included into the image. Configure
the image by adding Decorations (logo, legend, headline). Your company
logo can be included if you activate show logo in headline. Specify a com-
pany logo file by clicking the icon next to the field. This will open a file
dialog. Add Overlays as needed (analyses, reference objects, measurements,
isosurface). See also Save image(s)... on page 3-9.
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Quit

Close the application.
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hrough the Edit menu of myVGL you can access the undo/redo and
cut/copy/paste functions. The menu also enables you to edit general
application settings.

Table 4-1: Edit menu options lists the menu entries with a brief descrip-
tion. They will be explained in detail later in this chapter.

Option Icon Description

fTrr1rrrrrrrrININRRRRRNNRRRRRORORRRRORRORRRRNRRRRRRRRRELLDY

Undo i) Undo the latest action/command

Redo [ Redo the latest action/command

Clear undo Delete all entries stored in the undo queue

queue

Delete Remove the currently selected object(s) from
the scene (with partial buffering, see
Undo/Redo)

Preferences... Set general application parameters and options

(+ dialogs) -

1 (I} 1
TABLE 4-1: EDIT MENU OPTIONS

Undo / Redo

Most actions can be undone (and then redone to reestablish the situation
before undo). Actions which change the underlying data or otherwise
require a lot of memory (e.g., filtering) may not be available for undo/redo.

The amount of memory allocated for the undo queue can be set by editing
the Preferences as described later in this chapter (see Preferences on

page 4-2). Should the last issued command require more storage space
within the undo queue than currently available, then myVGL will start eras-
ing entries in the queue beginning with the oldest command in the queue
and proceed chronologically until enough storage space becomes available.
If a command requires more space than is available for the undo queue,
then the command will not be stored and the current command history is
erased.

If you think you might want to undo an action which requires a lot of mem-
ory, save desired images or image stacks prior to the action.
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Clear undo queue

Clear undo queue

The command history of the current myVGL2.0 session is stored in the undo
queue. Clear undo queue will erase the accumulated command history. The
command history will be erased automatically if an action requires more
memory than is available to the undo queue.

Delete

Deletes the selected object(s) from the scene. The object(s) can be (par-
tially) restored using Edit > Undo. Analysis results (e.g., from a wall thick-
ness analysis) are not restored.

Preferences

Set general application parameters and options according to your prefer-
ences. These settings apply to myVGL in general and not only to a specific
project.

You can save these settings as presets in order to load them at a later time.
Presets can also be deleted, exported and imported.

GENERAL

Dump core file
Specify if a core dump should be executed if the program terminated unex-
pectedly.

Print / Save image(s)
Specify if changes in the Save image(s) dialogue should be saved.

Undo
Specify how much memory can be used by the Undo function.

Rendering settings for imported data
Specify which rendering algorithm and if shadows are to be used by
default.

Slice window

If you choose Medical mode, the slices in the 2D window showing the xy-
plane are looked upon from the Bottom instead from the Top. This only
becomes effective if the window is in one of the standard layouts.

The Level/Window mode checkbox determines whether the { Set bright-
ness button is available in the slice views.
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Icon theme
Specify if you want large or small icons.

Hardware renderer

In this section you see the Graphics Card that is used by the Hardware ren-
derer and you can determine how much of its memory can be used for ren-
dering.

Application user interface
Specify if once message boxes should be displayed again after checking the
“never show again” checkbox.

ANNOTATION ARRANGEMENT

N R R N R R R R R R R R R R R R RN Y
In this section you can determine the behaviour of the Annotations > Arrange
function. The Allow overlap setting specifies, which objects may be con-
cealed by the annotations: The Object only, the Colortable only, Both or None.

The Strategy parameter determines where the annotations should be posi-
tioned: At the Window border or Around the object.

The Alignment X /Y settings determine how annotations of non-uniform size
should be positioned with respect to each other.

The Center parameter specifies if the distribution of the annotations should
be determined by the center of the Object, of the Window or Automatically.

The Margin values determine how much space should be between annota-
tions, and the Border values determine how far away from the window bor-
der the annotations should stay. For both parameters, the first setting
determines the x value and the second setting the y value.

The Grid snap checkbox determines if the annotations snap to a grid when
you shift them manually. If activated, you can determine the grid spacing
by the Grid snap step setting and the grid origin by the Grid snap offset set-

ting. For both parameters, the first setting determines the x value and the

second setting the y value.

If the number of visible annotations in a window increases above the Max.
visible annotations parameter, all annotations are hidden.

COORDINATE SYSTEM DISPLAY

Box

Here you can specify the look of the coordinate system box: You can mod-
ify the font, color, outline, alignment and style of the labels. Furthermore, you
can specify if you want to show the box frame, ticks, labels, grid and back-
ground. You can also extend the box by a certain distance in each direction.
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The color of the box background, box frame, ticks and grid can also be
specified.

®  Tripod
Here you can specify the color of the tripod axes.

SNAP FRAME

R R R R R N Y
Here you can set the default mode of the snap frame. Furthermore, you can
define its size, either in pixels (Display relative mode) or in physical units
(e.g. mm; Scene relative mode).

TEXTOVERLAY

Here you can define the look of the text overlay: You can set the font size,
color and type and specify the distance to the border of the 2D/3D window
(Cell border). If you click the Configure button, the Text Overlay Editor will
open (see chapter Text Overlay Editor).

UNIT

N SRR R R R R R R R R R R Y
Here you can define with which precision a Length, Area, Volume, Angle,
Time or Storage value should be displayed. You can do so by setting the
number of decimal places or the respective absolute precision value.

Slice elements

ISOSURFACE

Here you can define the look of the isosurface line in the 2D windows, both
for selected and unselected volumes.

REGION OF INTEREST

Here you can define the look of the ROIs line in the 2D windows, both for
selected and unselected volumes.

Analysis

COORDINATE MEASUREMENT

® Features
In the General section you can specify the size and type of Feature handles.
Furthermore, you can decide if handles should Snap to a grid with a speci-
fied Grid distance. You can also define the font type, color, size and outline
for feature descriptions here.

In the Color, selected instrument section you can determine the look of Fea-
tures that belong to a selected instrument: You can specify the color and
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width of the respective Subsidiary lines, Handles, the selected Feature itself
and unselected features belonging to the same selected instrument (Fea-
ture). Each subsection allows you to set a specific style for items in the slice
plane, behind the slice plane and in front of the slice plane.

Similarly, you can determine the look of Features that do not belong to a
selected instrument in the Color, unselected instrument section.

Instruments

In the General section you can specify the length of Instrument handles. Fur-
thermore, you can decide if Indicator annotations should be visible in all slices.
Also, you can set the size of the Navigation cursor here.

In the Color, selected section you can determine the look of Instruments with
features, instruments without features (Instruments) and their Handles. Each
subsection allows you to set a specific style for items in the slice plane,
behind the slice plane and in front of the slice plane.

Similarly, you can determine the look of unselected Instruments in the Color,
unselected section.

Reference objects

In the General subsection of both the 2D and 3D display settings sections, you
can define how points are displayed in the respective windows. This
includes both fit points and auxiliary points , for example the center pionts
of cylinders. Furthermore, you can decide if you want to display annotations
for selected reference objects in 2D or 3D windows. In the 3D display set-
tings, you can also set the Reference object grid spacing and if you want
Shaded reference objects (only applies if Fill mode in the Color subsection is
set to On).

In the Fitpoint colorbar subsection of both the 2D and 3D display settings sec-
tions, you can define how the Fitpoint colorbar is displayed in the respective
windows: You can set its visibility, width, length, font style and title (Cap-
tion).

In the Color subsection of both the 2D and 3D display settings sections, you
can define the look of Selected, Highlighted and Unselected Reference Objects.
Highlighted Reference Objects are those that belong to a selected feature. In
the 2D display settings section, you can set a specific style for items in the
slice plane, behind the slice plane and in front of the slice plane.

DEFECT DETECTION

2D display settings
In the Annotations section you can define the size of the annotation cursor in
the 2D windows, whether a newly created annotation should be minimized
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or maximized (Default annotation size) and whether the annotations should
be visible in all slices or just at their cursor position.

In the Colorbar section you can define whether you want the result colorbar
displayed in the 2D windows and how you want it to look there: You can
define its width, length, position and font style.

3D display settings

In the Annotations section you can define the size of the annotation cursor in
the 3D window and whether a newly created annotation should be mini-
mized or maximized (Default annotation size).

In the Colorbar section you can define whether you want the result colorbar
displayed in the 3D window and how you want it to look there: You can
define its width, length, position and font style.

NOMINAL/ACTUAL COMPARISON

2D display settings

In the Annotations section you can define the size of the annotation cursor in
the 2D windows, whether a newly created annotation should be minimized
or maximized (Default annotation size) and whether the annotations should
be visible in all slices or just at their cursor position.

In the Colorbar section you can define whether you want the result colorbar
displayed in the 2D windows and how you want it to look there: You can
define its width, length, position and font style.

In the Isosurface section you can define if you want the isosurface in the 2D
windows colored according to the local variance value, if you want addi-
tionally Haired lines whose length corresponds to the respective variance
value or no color coding at all (No line). You can define the width of the col-
ored line. For Haired lines, you can also specify the distance between hairs
and the multiplication factor between the variance value and hair length
(Hair scale factor).

3D display settings

In the Annotations section you can define the size of the annotation cursor in
the 3D window and whether a newly created annotation should be mini-
mized or maximized (Default annotation size). The Cursor color follows overlay
checkbox determines whether the 3D cursors should be colored according
to their variance or not.

In the Colorbar section you can define whether you want the result colorbar
displayed in the 3D window and how you want it to look there: You can
define its width, length, position and font style.
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WALL THICKNESS

2D display settings

In the Annotations section you can define the size of the annotation cursor in
the 2D windows, whether a newly created annotation should be minimized
or maximized (Default annotation size) and whether the annotations should
be visible in all slices or just at their cursor position.

In the Colorbar section you can define whether you want the result colorbar
displayed in the 2D windows and how you want it to look there: You can
define its width, length, position and font style.

3D display settings

In the Annotations section you can define the size of the annotation cursor in
the 3D window and whether a newly created annotation should be mini-
mized or maximized (Default annotation size).

In the Colorbar section you can define whether you want the result colorbar
displayed in the 3D window and how you want it to look there: You can
define its width, length, position and font style.
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INSTRUMENTS MENU

ou can perform various measurements like distances, gray values,

angles and more on your data with the utilities available in the

Instruments menu of my¥GL. Each new instrument will be accompa-
nied by an annotation containing the respective measured value(s) and rep-
resented by an entry in the Scene Tree (see chapter Scene Tree tool).

warning For useful results, the object must have been calibrated.

Measurement instruments are visible in the 2D views and—unless hidden
by opaque material—in the 3D view. See Table 5-1: Instruments menu
options for an overview.

Option Icon Description

frr1 N IIRNRRRNRNNORNORORRORORORORORORORORIORORIORINRIRORIRRORORIRORIRIRIRIOLEOLDY

Indicator Left-click to create a new indicator to measure
gray value and position of a single voxel

Distance instru- L Left-click and draw with the mouse to measure

ment a distance

Anglte instru- ) Left-click to create a new angle instrument

men

Polyltine instru- £ Left-click to create a new polyline instrument

men

Caliper instru- A% Left-click and draw with the mouse to measure

ment a distance rectangular to a surface

Activate naviga- .‘;.I.. Left-click while pressing the <Ctr/>-key to

tion cursor position the navigation cursor, left-click and
drag to move it

Snap modes F%‘ Choose a mode from the submenu to deter-
mine the snapping behavior when setting
points or handles

frr1 N IIRNRRRNRNNORNORORRORORORORORORORORIORORIORINRIRORIRRORORIRORIRIRIRIOLEOLDY

TABLE 5-1: INSTRUMENTS MENU OPTIONS
General

Handling of instruments
To create a new instrument, choose one of the options in the Instruments
menu and click with the mouse into a slice window. The polyline instru-
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ment, the indicator and the navigation cursor can also be positioned in the
3D window.

To modify an instrument, select it in a slice window, 3D window (polyline
instrument, indicator and navigation cursor only) or Scene Tree (see chapter
Scene Tree tool) and resize it with the left mouse button: Click one of its
handles to drag it, click onto the instrument’s base line to move the whole
instrument.

Warning

In the 3D window, instruments are manipulated differently than in the 2D
windows:

In the 3D window, double-click instruments with the left mouse button to
select them, and hold <Ctr/> while left-clicking to create new points
(polyline instrument) or set it to another point (indicator and navigation
cursor).

In the 2D windows, a single left-click is sufficient for both actions.

Selecting an instrument in 2D or 3D will change the slice display such that
all 2D views display the slices in which the instrument is located.

Display of instruments
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An instrument is always displayed in the 2D views, whether or not the cur-
rent slice is the slice the instrument is located in. The way the instrument is
displayed is subject to its position relative to the current slice. You can
modify the display properties in the preferences (see Preferences in chapter
Edit menu on page 4-2). The default settings are as follows.

Display of punctiform measurement instruments
Indicator and navigation cursor are displayed in

¢ red if located in the current slice,
» green if located in a higher slice,

» white if located in a lower slice.

Display of linear measurement instruments

» If a measurement line is located in the current slice, it will be displayed
as a solid green line with red handles. The handles will only be
displayed in the slice in which they are located.

» Ifameasurement line is located in a lower slice, it will be displayed as a
solid green line without handles.

* If a measurement line is located in a higher slice, it will be displayed as
a dashed green line without handles.
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Indicator

This also applies for parts of the line. If a line runs diagonally through the
object, the upper part of it will be displayed dashed and the lower part
solid.

Tips and tricks

For the linear measurement instruments, you can view the gray value
profile along the measurement line (see chapter Window menu) or perform

a dimensioning (see chapter Measurements menu).

Annotations

Specify the positioning of the instrument’s annotation in the view. Move
your mouse over the annotation and click on the small button appearing
above the upper right corner of the annotation to switch between the fol-
lowing modes:

A (Automatic positioning mode)

Places the annotation automatically, thereby avoiding intersections
between the annotation line and the instrument line. This option is only
available for Distance and Caliper instruments.

F (Fixed positioning mode)
Places the annotation at a fixed position in the respective 2D window.

R (Relative positioning mode)
Places the annotation at a position relative to the instrument.

For advanced measurement features, coordinate measuring and coordinate
system options see chapter Measurements menu.

Indicator

The indicator is a 3D cross-hair that points to a single voxel. Its annotation
contains the gray value of the voxel and its x/y/z coordinates in units of the
selected coordinate system. If the coordinate system is the grid of the object,
the position will be given in voxels.

Distance instrument

T
Use this tool to measure a distance between two points. If you want to mea-
sure e.g. the material thickness, activate the snap option as explained above
(see Annotations on page 5-3) so that the handles of the distance instru-
ment are automatically positioned on the material boundary.

The handles of the distance instrument can be dragged using the left mouse
button. Hold down <Shift+Ctrl> while doing so to leave the direction of
the distance instrument unchanged (other than changes of 45°).
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Angle instrument

If you hold <Shift> while dragging a handle, its movement is restricted to
the horizontal or vertical direction in the respective 2D window.

The whole distance instrument can be moved by dragging the line between
the handles (using the left mouse button).

To measure another distance with the same distance instrument, simply draw
at a new position. Select another object or deselect the instrument in the
Scene Tree to stop modifying this distance instrument.

To measure another distance with an additional distance instrument, choose
this menu entry again.

Angle instrument

ftfrrr PR NNRRRRRRNORORRRBRRORORRRORIRORIRIRIRIRIRRRRRIRIRRRERRERLLDY
Use this tool to measure the angle between two edges. The angle instrument
consists of two lines, each with two handles.

You can drag the handles with the left mouse button. By doing so you
define the angle between the two lines which is displayed within the anno-
tation of to the angle instrument.

If you hold <Shift+Ctrl> while dragging a handle, the direction of the cor-
responding line is locked and will only change in steps of 45°.

If you hold <Shift> while dragging a handle, its movement is restricted to
the horizontal or vertical direction in the respective 2D window.

The whole angle instrument can be moved by dragging one of the green lines
between the handles (using the left mouse button).

Polyline instrument

Use this tool to measure the outline of an arbitrary shape by fitting a
polyline to that shape. Click the left mouse button to create control points
for the polyline instrument. The new points are added to the start or the end of
the polyline, depending on whether the cursor is nearer to the current start
or end point, respectively. The start and end point are distinguished from
the other points by their different display. Each successive line segment
adds to the total length. Insert a point between two existing points using the
middle mouse button. Remove a point by clicking it with the middle mouse
button.

Manipulate the polyline instrument in the 3D view by holding down <Ctr>
during the respective mouse clicks. To move an existing point of a selected
polyline instrument no modifier key is needed. Double click the polyline instru-
ment with the left mouse button to select it.
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Choose the polyline type from the floating toolbar:
* Linear connects the points with straight lines.

* CatmullRom connects the points by a Catmull-Rom-Spline. Modify the
Slope factor to increase or decrease the curvature of the. A Slope factor of
0.0 leads to the same result as a Linear polyline.

The annotation shows the distance measured along the polyline.

Caliper instrument

T R R R R Y
Like the distance instrument, the caliper instrument is used to measure dis-
tances. The caliper can be regarded as a distance instrument enhanced by a
additional line at each end. The additional lines are in a fixed right angle to
the distance measurement line. Use the additional line to position one end
of the distance measurement line rectangular to a surface. Then position the
other end of the distance measurement line, e.g. onto the opposite surface,
to measure the distance.

If you hold <Shift+Ctrl> while dragging a handle, the direction of the cor-
responding line is locked and will only change in steps of 45°.

If you hold <Shift> while dragging a handle, its movement is restricted to
the horizontal or vertical direction in the respective 2D window.

If you change the coordinate system, the additional lines of the caliper will
not be displayed. They become visible again if you switch back to the coor-
dinate system in which they have been created.

Activate navigation cursor

The navigation cursor allows easy navigation in the scene: Hold <Ctr/> and
left-click a point in any (2D or 3D) window to position the navigation cursor
there. The position specified this way will be shown in the other 3 win-
dows; 2D windows will update their slice index to do so. Use the left
mouse button to drag the navigation cursor around. Hold <C#r/> and left-
click somewhere to set the cursor to a new position.

Tips and tricks

If you are interested in a specific point located on the surface of the object,
position the navigation cursor on this point by <Ctr/>-clicking it in 3D. All
2D windows will display the slices for this point so that you can investigate
it further.
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Snap

If another instrument is selected, the navigation cursor can be brought back
to focus in the 3D window by <Ctr/>-clicking somewhere within it.

Snap

Activate one of the snap options from the pull down menu to automatically
snap the points/handles you set for the measurement instruments. The snap
works both for volume and geometry objects in the 2D view. If a volume
object has been calibrated, the calibrated isosurface can be used for snap-
ping.

Activate this option to display a square capture frame. The point snaps
inside this capture frame. Define the snapping area inside the preferences
(see Preferences in chapter Edit menu on page 4-2).

Disable this option to set the points/handles exactly where you click.
Enable an arbitrary snapping mode for geometry objects to snap onto their
surface.

Use one of the following snap options from the pull down menu for the
instruments in the 2D view:

% | Snaps to the lowest gray value in the snap area.

I: Snaps to the highest gray value in the snap area.

Snap modes > Gradient

% Snaps to the position with the largest gray value difference in the snap
area.

Snap modes > Nearest

Snap modes > Local
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E{ Snaps to the nearest isosurface created by the calibration in the snap
area. If there is no calibration present, this modes works like the snap mode
Local.

Performs a temporary, local calibration within the snap range and
snaps to the resulting temporary isosurface.
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he Object menu of myVGL allows you to manipulat:e the objects in
the scene (like voxel objects or polygon models, but also clipping
planes etc.).

See Table 6-1: Object menu options for an overview.

Option Icon Description
Rotate Enables rotating the object in 3D.
Move Enables moving the object in 3D.

Create clipping

Creates a clipping plane for the selected
plane

object.

Create aligned Creates an aligned clipping box for the

i de B B4

clipping box selected object.

greate clipping Creates a clipping box for the selected object.
oX

Properties Displays object properties.

TABLE 6-1: OBJECT MENU OPTIONS

Rotate / Move

Toggle between rotate mode and move mode for the selected object(s) in
the 3D window. The current mode can be identified by the color of the
bounding box of the object in the 3D window: A red bounding box indi-
cates rotate mode, a green bounding box indicates move mode.

For more details please refer to Move / Rotate mode in chapter Workspace
on page 2-2.

Clipping

Either create a clipping plane, a clipping box or an aligned clipping box for
the selected object(s). For more information about clipping objects, please
refer to chapter Clipping tool.
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Properties

Properties

Displays information about the selected object. For more information,
please refer to Properties in chapter Scene Tree tool on page 12-4.
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RESULT MENU

hrough the Results menu of myVGL you can access results of
advanced analysis features. With myVGL, you can view the results
of, but not perform, an analysis.

See Table 7-1: Results menu options for an overview.

Option lcon Description

ffrrrr BB LRRRRRRRORRRNORORCRRRRRORIRIRIRIRIRIRIRIRERIRRIRRRRRRRRERRELELDY
Defect detection S Open the results of a Defect detection analysis.
Nominal/Actual + Open the results of a Nominal/Actual comparison.
comparison

Wall thickness E':' Open the results of a Wall thickness analysis.

CM reporting ‘{, Open the results of Coordinate measurements.

(I}
TABLE 7-1:

1 LI B ] [ }
RESULTS MENU OPTIONS

Nominal/Actual comparison

Visualizes the variations between the calibrated surface of a voxel object
and the surface of a polygon model.

See chapter Nominal/actual comparison module for details.

Wall thickness

Visualizes the material thickness of a voxel object.

See chapter Wall thickness module for details.

Defect detection

Visualizes the material defects of a voxel object.

See chapter Defect detection module for details.

CM Reporting

Visualizes the material defects of a voxel object.

See chapter Measurements menu for details.
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TOOLS MENU

ﬁ ctivate various tools by checking their entry in the Tools menu of
myVGL.

See Table 8-1: Tools menu options for an overview.

Option Icon

| I I DN D B B IO D B DO RO RO D DN D BN RN NN DN B B RN DN DN D DN BN BN NN BN DN BN RN NN DN BN RN BN DN DN B B BN RN B BN BN BN BN B B )

Volume Ren- define opacity, intensity and color mappings

dering for volume objects

Scene Tree access and control elements (and their subele-
ments) in the scene, this includes camera and
light sources, volume objects and surface mod-
els, measurement features, clipping planes,
and others

Clipping control the clipping plane

golygon Ren- specify the rendering of surface models

ering

Transform access and control the transformation proper-
ties of volume objects and surface models,
these include the position, rotation, resolution
and center of an object

Light access and control the properties of light
sources in the scene, these include the type
(e.g., spot light source), color, shadow, and
others

Camera access and control the properties of the cam-

era, these include its position and focal point,
the rendering mode and others

1 RN
TABLE 8-1: TOOLS MENU OPTIONS

Check a tool to activate it. An activated tool will be displayed either in one
of the tool docks or as a floating tool. It might be minimized to its title bar
or maximized. Position and size of the tool depends on its status before it
was deactivated.

Uncheck a tool to deactivate it. You can reactivate the tool at any time.

Deactivating a tool via the Tools menu is equivalent to closing the tool via
the corresponding icon in its title bar.

For details on the tools, refer to the respective chapters.
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hoose and/or modify the overall layout of views in myVGL. This
includes the 3D and 2D views to be displayed, their size and
arrangement as well as display of rulers and text overlays.

See Table 9-1: Window menu options on page 9-1 for an overview.

Option Icon Description

Slices Left H:l Applies a standard two column layout with
three slice views and a large 3D view. The
slice views are arranged top to bottom in the
left column.

Slices Right EH Applies a standard two column layout with
three slice views and a large 3D view. The
slice views are arranged top to bottom in the
right column.

Slices Below E Applies a standard two row layout with three
slice views and a large 3D view. The slice
views are arranged left to right below the 3D
view.

Quad E Applies a standard two by two layout with
three slice views and a 3D view, where each
view of the quad is of the same size.

Background Select the Background color for the selected
2D window.

Coordinate sys- Select a reference coordinate system for the

tem respective 2D window.

Zoom Controls the zoom setting of the selected 2D
view.

Ruler Activate to display rulers in the slice views.

Display Mode Changes the Display Mode (data representa-

tion) of the 2D views.

Annotations Rearranges and configures annotations

TABLE 9-1: WINDOW MENU OPTIONS
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Slices Left/Right/Below

Option Icon Description

Level/Window Toggles the 2D view Level/Window (Con-

mode trast/brightness) mode.

Slice step width Defines step width to be used for navigation in
2D view (if not in “Grid” coordinate system).

Text overlay Configures text overlays for slice views and/or

editor 3D view

TABLE 9-1: WINDOW MENU OPTIONS

Slices Left/Right/Below

Select one of the window layouts with a larger 3D view and apply it to your
current workspace.

Quad

Select this layout to apply a standard two by two layout with three slice
views and a 3D view.

Background

Specify the background color of the 2D windows here.

Coordinate System

T R R Y
Here you can specify a reference coordinate system for the selected 2D
window. Other 2D windows will not be affected by this choice. Select Fol-
low global coordinate system to reference the coordinate system active in the
Coordinate system iconbar.

Zoom

f1r1rr N INLINRRNRORRRBRRORORRRORORORORIRRIRIRIRRRRIRIRIRRRRILLDY
You can zoom in or out, fit an object or a scene to the window or reset to
the original zoom factor.

Ruler

Select this option to toggle the ruler at the borders of each 2D window.
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Color

Color and Opacity

WINDOW MENU
Display mode

Display mode

The Display mode determines the way by which the slice images in the 2D
views are rendered.

Displays the slice images using their original color, brightness and contrast.

Displays the slice images using their original brightness and contrast, but
applies the color setting from the Volume Rendering tool. Also displays the
contour of the calibrated surface.

Displays the slice images using the brightness, contrast and color settings
of the Volume Rendering tool. Also displays the contour of the calibrated sur-
face.

Annotations

ftfrrr PR NNRRRRRRNORORRRBRRORORRRORIRORIRIRIRIRIRRRRRIRIRRRERRERLLDY
Select Arrange, Minimize, Maximize to modify the display of the currently vis-
ible annotations.

Refer to e.g. Annotations in chapter Nominal/actual comparison module on
page 20-6 for instructions on how to create an annotation.

Level/Window mode

Launches the Level/Window (contrast/brightness) tool. This can be used to
change the displayed Level/Window of the volumetric data independent of
the Volume Render settings. The chosen settings are taken into account in all
the Display Mode settings.

Slice step width

Here, you can define the step width to be used when scrolling through
slices in the 2D views. It is only active when one is not in a “Grid of ...”
coordinate system.

Text overlay

Launches the Text Overlay Editor for the 2D and 3D windows. Via this tool
additional information such as slice position and company logos can con-
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Text overlay

figured and rendered on top of the 2D and 3D views. For further details see
chapter Text Overlay Editor.
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HELP MENU

he Help menu of myVGL2.0 provides information about the software
and provides access to the manual.

Option Icon Description
frrrrrrrrrrrrrIr NN NNRNNRRRNORRRNORRRRORORORNORRRNORRRNORORRORIRRROEOLN
About v Display product information

Show manual Displays the reference manual

[ } [ B ]
TABLE 10-1: HELP MENU OPTIONS

About

Displays product information including the version (release) and build
number.

Always provide version and build number when requesting support or
reporting a bug.

Show manual

Displays this reference manual.
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VOLUME RENDERING TOOL

olume objects can be visualized with various rendering techniques
-\/ by myVGL2.0. The Volume Rendering tool allows to manipulate the
look of volume objects or parts of them in various ways: You can
choose a color for each object, apply user-defined transfer functions to its
opacity, set its overall transparency, and pick a rendering algorithm.

Preset selection

If you choose one of the default or user defined settings most changes in
the tool are overwritten and lost. The red flag next to a preset name indi-
cates that changes were made to it.

To save your own presets choose Save preset from the right pull down
menu.

To save and load the settings into or from a file choose Export preset or
Import preset.

When saving, you can choose if you want to save an Absolute Preset, i.e. a
preset that maps properties to absolute grayvalues. If the checkbox is not
activated, properties are saved relative to the histogram length.

You can choose between the following predefined presets:

* Ramp sets a ramp from left bottom to right top in the Opacity manipulation
area, sets the colors to white and causes the object to be rendered as a
volume.

The result is a gray shaded volume object. Low gray values have high
transparency and are shown with low intensity. High gray values have
high opacity and are shown with high intensity.

* Inverse Ramp sets a ramp from left top to right bottom in the Opacity
manipulation area, sets the colors to white and causes the object to be
rendered as a volume.

The result is a gray shaded volume object. Low gray values have high
opacity and are shown with high intensity. High gray values have high
transparency and are shown with low intensity.

* Components sets the opacity to maximum for all gray values, sets a color
gradient for Ambient and causes the object to be rendered as a volume.
The result is a completely colored object. Every gray value has another
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VOLUME RENDERING TOOL
Opacity manipulation area

color. This is a good setting to visually detect the components of the
object. Use the aligned clipping box to look into the object.

* Isosurface Transparent sets the colors to white and causes the object’s
surface(s) to be rendered transparently. The threshold of the iso surface
is shown as a red vertical line in the Opacity manipulation area. Change it
with the mouse interactively.

Opacity manipulation area

In this area you see a histogram of the selected object and can specify the
opacity of its voxels depending on their gray value using the opacity transfer
function. The opacity transfer function is represented by the gray line plotted
over the histogram. It can be manipulated as described in the following.

opacity transfer function

Set handles by clicking with the middle mouse to define supporting points
of the transfer function. The transfer function is linearly interpolated
between the supporting points.

You can move handles or whole sections of the opacity transfer function by
dragging them with the left mouse button.

Delete handles by middle-clicking them or by right-clicking them and
choosing Delete handle from the context menu.

Move the mouse over the handle to see its gray value followed by its
assigned opacity value.

Choose Reset opacity curve > from the context menu and the respective sub
menu entry to set the transfer function to Default (Ramp), Full transparent or
Full opaque.

Choose Copy opacity curve from the context menu and Paste opacity curve to
copy the curve into the area of another object.

Warning

The opacity transfer function has no effect on the 3D window when the
isosurface renderer is chosen. You can however still see the effects in the
2D window when you set them to Color and Opcacity mode.

Gray value histogram and zoom
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Click into the background of the histogram with the left mouse to show its
zoom level and gray value range. Move the mouse now up or down to
change the zoom.

Use the &, icon or &4 - icon to reduce or enlarge the section of the gray
values.

Choose Histogram > Disable histogram to disable the histogram in the back-
ground.
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Appearance

Tips and tricks

Dock the tool window out from the tool bar and resize the window
horizontally as large as possible to see the histogram in more detail if you
have an object with thousands of gray values.

Intervals

Use the intervals to disable or enable a gray value range. If an interval is
disabled the opacity is set to zero for its gray value range.

Per default you work always in the Interval 1. Move the mouse to the right
or left border of the area, hold down the left mouse and move into the mid-
dle of the area to create an additional interval. Move the blue boundary line
of the interval to scale both the opacity and color transfer function. Click
with the left mouse onto the name of the interval to change it.

The context menu allows various options:

Choose New interval > At left side to divide up the existing interval into two
intervals on the actual mouse position with the new interval on the left side.
Choose Delete interval > Expand left neighbor to delete the interval on the
actual mouse position and merge the freed region with left interval.
Choose Disable or Enable interval to disable or enable the interval on the
actual mouse position.

Define the surface of the selected object by moving the red vertical line
with the mouse. This sets the gray value at which the isosurface renderer dis-
plays the surface of the object.

Tips and tricks

If the object was calibrated you have to click the small gaf icon on the right
to unlock the vertical line if you want to set the surface by hand.

Ambient

Appearance

N R R R R R R Y
Define the color transfer functions, overall transparency and some isosur-
face specifics here.

The color and intensity defines how much of the light is reflected from the
object’s volume or surface.

Specify the properties of the Ambient component of light reflected from the
selected object here. See Color and Intensity in chapter Light tool on
page 16-3 for details on the different light components.

Set handles by clicking with the middle mouse to define supporting points
of the transfer function. This defines a mapping between the gray value of
the object and the color. The transfer function is linearly interpolated
between the supporting points.

Release 2.0 myVGL Manual 11-3



VOLUME RENDERING TOOL
Appearance

Move the handles by clicking with the left mouse.

Use the right mouse on a handle and delete it by choosing Delete handle
from the context menu.

Click the handle with the left mouse to see its gray value.

Choose Set handle color > to set the color for a handle. Choose Set color
between handles > to set the color between handles. Choose Set interval color
> to set the color for the whole interval.

Warning

Set interval color > removes all handles inside the interval.

Diffuse

Specular

Transparency
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Copy the interval color by choosing Copy interval color and Paste interval color
from the context menu.

Use the spinbox to set the Intensity of the color.

Specify the properties of the Diffuse component of light reflected from the
selected object here. See Color and Intensity in chapter Light tool on
page 16-3 for details on the different light components.

Set the color transfer function in the same way as done for Ambient above.

Use shared color to use exactly the same transfer function for the diffuse
component as for the ambient component. Change the intensity indepen-
dent from that. The old transfer function is restored if the option is deacti-
vated.

Specify the properties of the Specular component of light reflected from the
selected object here. See Color and Intensity in chapter Light tool on
page 16-3 for details on the different light components.

Double click the quadratic box to choose the color for the Specular compo-
nent. Use the spinbox to set the Intensity of the color.

The Shininess controls the size and brightness of the highlight of the specu-
lar component.

Use the spinbox to set the overall Transparency of the selected object. This
changes the intensity of the opacity in the Opacity manipulation area. The
opacity is the inverse of the transparency. It is the equivalent of the Intensity
of the color transfer functions Ambient and Specular.

Enable Remove hidden surfaces to disable the rendering of surfaces inside
the object. This has an effect only if the surfaces are transparent.
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Rendering settings

Swap
Choose Swap inner/outer areas to set inner areas to outer areas and vice
versa. This is for the Isosurface renderer only. The figure below illustrates a
common use of this switch.

Swap inner/outer areas off Swap inner/outer areas on

Rendering settings

For each object in the scene, you can specify which rendering algorithm to
use to display it in the 3D window (and any screenshots or movies derived
from it).

Isosurface renderer

This algorithm displays the surface of the selected object as defined by the
iso-level (red line in the Opacity manipulation area). It is recommended for the
analysis and visualization of industrial CT data sets: This algorithm pro-
duces high quality photorealistic images at interactive speeds almost inde-
pendently of the size of the data set. The most common use of the isosurface
renderer is to render the object at the iso-level defined by the calibration, i.e.
showing the actual calibrated surface of the object.

Volume renderer (Phong)
This algorithm is a volume rendering algorithm which emphasizes the local
gradients within the voxel data. The full support of lighting sources and
clipping objects makes it most suitable for animations.

Volume renderer (Scatter HQ)
This algorithm is a volume rendering algorithm. It is the “all-rounder”
amongst the visualization algorithms of myVGL. It is well suited for the
visualization of faint gray value differences within the voxel data as well as
to visualize surface structure details.
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Rendering settings

Hardware renderer (Scatter HQ)

X-Ray

Sum along Ray

In contrast to all other renderers, which all use the CPU (s) for rendering,
the Hardware renderer uses the graphics card for direct-volume-rendering.
This delivers the best rendering performance on most systems but uses the
least features of the light and clipping objects. However, for data sets larger
than the graphics card memory the Hardware renderer can be used as pre-
view only, because the volume has to be downsampled and looses detail.

The X-ray algorithm casts one ray per display pixel into the dataset. The
higher the integrated opacity of voxels along a ray, the darker the corre-
sponding pixel.

The Sum along Ray algorithm casts one ray per display pixel into the dataset.
The higher the integrated opacity of voxels along a ray, the brighter the cor-
responding pixel.

Maximum Projection

Scatter (v1.2)

Scatter HQ (v1.2)

The Maximum intensity projection algorithm casts one ray per display
pixel into the dataset. The maximum intensity of the voxels along a ray
determines the gray value of the corresponding pixel.

This algorithm is a volume rendering algorithm which is suited best for the
visualization of transparent structures only, e.g. in computational fluid
dynamics.

This is the standard volume rendering algorithm from myV6GL 1.2. See “Vol-
ume renderer (Scatter HQ)” for more details.

Scatter Gradient (v1.2)
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This algorithm is a volume rendering algorithm which emphasizes the local
gradients within the voxel data. Therefore it is suited best to visualize
objects with a clearly defined surface structure.

REMARKS ON RENDERERS

Some renderers are adopted from VGStudlo Max 1.2: VGStudio MAX 1.2 (Scat-
ter), VGStudio MAX 1.2 (Scatter HQ), VGStudio MAX 1.2 (Scatter HQ Gradient),
VGStudio MAX 1.2 (X-Ray), VGStudio MAX 1.2 (Sum along Ray) and VGStudio
MAX 1.2 (Maximum Projection). You can use those to display data that was
saved in VGStudio Max 1.2 or VGStudio 1.2.
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Tips and tricks

Note that the VGStudio MAX 1.2 (X-Ray), VGStudio MAX 1.2 (Sum along Ray)
and VGStudio MAX 1.2 (Maximum Projection) are not dedicated to old data sets
only, but can be used with their full functionality in myVGL2.0.

Oversampling

Normalize gradients

The renderers Volume renderer (Scatter HQ) and Volume renderer (Phong) are
similar to VGStudio MAX 1.2 (Scatter HQ) and VGStudio MAX 1.2 (Scatter HQ
Gradient) respectively, but fully support the attributes of light and clipping
objects of myVGL2.0 and have higher precision by nearly the same perfor-
mance.

Set the oversampling to a factor larger than 1.0 to sample the object more
precisely than one voxel distance. The higher the oversampling the slower
the rendering but the better the image quality.

Switch on to normalize the gradients for lighting calculations. This is sup-
ported by the Volume renderer (Scatter HQ), Volume renderer (Phong) and the
Isosurface renderer.

Limitations of specific renderers

The renderers Volume renderer (Phong) and Iso surface renderer support all
attributes of the light sources and clipping objects. To be compatible to the
myVGL 1.2.1 renderers the Volume renderer (Scatter HQ) does not support the
specular component and behaves very similar to the VGStudio MAX 1.2 (Scat-
ter HQ).

The VGStudio MAX 1.2 (x) renderers have some limitations:

* Only two light sources on the camera are supported. The first one is
always interpreted as directional light shining frontal onto the object.
The second one always is a directional light, too, and shines angular
from the right side. Shadow is supported on second light source only.
The specular component is not supported.

* The inversion of the clipping region of clipping boxes and the opacity
setting of all clipping objects is not supported.

The Hardware renderer has the following limitations:
* Only the colors and intensities of light sources are supported.

* Neither inverting the clipping region of clipping boxes nor opacity
settings of any clipping object are supported.
Due to restrictions of OpenGL, most systems support only up to six
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Limitations of specific renderers

clipping planes. In this context, every side of a clipping box that actually
clips the object counts as a separate clipping plane.

* Overlays used by the wall thickness and defect detection analysis to dye
certain wall thicknesses or defects are not supported.
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SCENE TREE TOOL

he scene in myVGL consists of all elements currently loaded. This

not only includes volume objects and polygon models, but also

measurement features, light sources etc. The scene is hierarchically
structured: For example, a volume object is at top-level, all measurements
and analysis results belonging to this object are ordered below it. This hier-
archical structure is depicted in the Scene Tree. The Scene Tree tool allows
you to access the elements of the scene.

Entries in the Scene Tree are preceded by an icon indicating the current
locking state of this element, clicking this icon will change the state. The
checkbox will toggle the visibility state. Additional access is provided by
the context menu which you can open by right-clicking the entry (or
entries) in question.

Entries in the Scene Tree

Click an entry in the Scene Tree to select it. Use the <Ctr/> key while click-
ing to select multiple objects.

A selected object is highlighted in the Scene Tree. In the 3D window, its
bounding box is displayed.

Any object-related operations will refer to the selected object. Selecting an
object in the Scene Tree is equivalent to selecting it in the 3D window.
Select an object in the 3D window by double-clicking it, deselect an object
by double-clicking another object or by double-clicking the background.

Tipsandtricks Double-clicking a volume or polygon object in the Scene Tree will show a
dialog listing all available properties of that object.
Delete
Delete a selected entry by pressing the <Del> key on your keyboard.
Rename
To rename a selected entry, click it or press the <F2> key.
Visibility

Activate the checkbox in front of an object to display it in the scene. Deac-
tivate the checkbox if the object shall not be displayed in the 2D and 3D
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Elements
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SCENE TREE TOOL
Entries in the Scene Tree

views. This will change the visibility status only, all other settings will
remain unchanged. If you want to toggle the visibility of multiple objects,
select them and click the right mouse button to bring up the context menu.
In the menu, choose the according visibility status.

A lock icon indicates the status of an object (not applicable for all types of
objects). In myVGL, the status of an object cannot be changed.

closed lock “’__|

The object is locked in the scene. This implies that rotating the object will
rotate the camera. The relative position of the object in the scene will not
be changed.

closed lock with a red R “'::J
The object has been locked in the scene after a registration.

open lock

The object is unlocked. This implies that rotating the object will change the
relative position of the object in the scene. Otherwise, the scene will remain
unchanged.

warning sign

If the basis of an analysis has changed (e.g. coordinate systems in case of a
nominal/actual comparison), the analysis is marked to indicate that the
results are no longer valid.

An icon indicates the type of each object. The following types of objects
are displayed in the Scene Tree:

volume objects @
top-level object, a red C in the icon indicates that the object has been cali-
brated, a red C+ indicates an advanced calibration

polygons A

top-level object

camera | @
top-level object, only one camera per scene

light sources 'y
attached to top-level objects, the scene should have at least one light source

regions of interest
attached to a volume object

features
attached to a volume or polygon object
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Menu options

instruments
attached to a volume or polygon object

reference objects
attached to a volume or polygon object

wall thickness results
attached to a volume object or a ROI, results of wall thickness analyses

defect detection results
attached to a volume object or a ROI, results of defect detections

nominal/actual comparisons
attached to a volume object or a ROI, results of nominal/actual compari-
sons

annotations
attached to analyses

clipping objects & ‘{, *

attached to a volume or polygon object

groups
top-level object, groups of top-level objects or of lower-level objects

Menu options

Right-click an entry in the Scene Tree tool for a menu listing available
options for the selected object(s). The menu will differ depending on the
type of the object(s). Menu options available for the selected object type
but currently not applicable will be disabled.

The options in this submenu will differ depending on the type of the
selected object.

GENERAL OPTIONS

Clipping plane / Clipping box / Aligned clipping box
Creates a clipping object of the selected type. The clipping will be applied
to the selected items in the Scene Tree.

ANALYSIS AND MEASUREMENT OPTIONS

Annotation (defect detection / nominal/actual comparison / wall thickness)
Creates an annotation for the selected defect detection, nominal/actual
comparison or wall thickness analysis respectively.
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SCENE TREE TOOL
Menu options

Import templates and apply them to the selected object.

Indicator annotations
Imports a template of indicator annotations containing information about
their positions, names and group affiliation.

Align slices to object

Visibility on / off

Delete

Rename

Reset

Properties
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Align slices to object
Aligns the slice views axis-parallel to a selected reference object or a
selected clipping plane.

Toggle the visibility of the selected item. This menu entry corresponds to
the visibility checkbox of each item but allows you to toggle the visibility
of multiple items at the same time.

Deletes the selected item. Equivalent to Edit > Delete.

Renames the selected item. If multiple items are selected, this menu entry
changes to Rename (multi) and leads to a dialog in which you can systemati-
cally modify the naming of multiple objects.

Resets the position and orientation of objects that are not locked to their
inital state.

Displays properties of the selected volume object, polygon model or analy-
sis object. You can also open this dialog by double-clicking an entry.
Choosing the properties option on analysis objects will show the according
analysis dialog. See the respective chapters for a detailed description.

For render objects the properties dialog consists of two tabs, General and
File list. The general property information varies depending on the type of
object (volume object or polygon model).

GENERAL PROPERTIES (VOLUME OBJECTS)
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The Data info section contains information on Endianness and Datatype (for
volume objects).

Release 2.0



SCENE TREE TOOL
Menu options

The overall scanned area is quantified in the Bounding box info. Note that
this usually comprises the surrounding air, not only the scanned object. The
bounding box is displayed in the 3D window.

The bounding box related information contains

* the Dimensions [voxel] in X, y, and z

* the Resolution on the x, y, and z axis, i.e. the size of a voxel in this axis
* the overall Voxel count in the bounding box

* the Dimensions in the scene unit (e.g. mm)

The Object info provides information on the scanned object as defined by the
calibration. This includes the dimensions of the smallest possible bounding
box around the object and the volume of the material (as defined by cali-
bration) in this bounding box. If the object is not calibrated, the results will
depend on the renderer (volume renderer or isosurface renderer).

GENERAL PROPERTIES (POLYGON MODELS)

N R R R R R R R R AR
The section Object info contains information on the number of vertices (Ver-
tex count) and triangles (Triangle count) defining the polygon. The object is
analyzed for Bad edges and Bad triangles.

Click the Update button if you are interested in the Surface area and the
Dimensions (X, Y, and z). The dimensions describe the smallest possible
bounding box around this object.

Clicking Update will analyze the angles in the triangles and display the
number of occurrences of the angles in a diagram.

FILE LIST

Displays a list of the files on disk containing the data of the selected object.
The information refers to the data as stored in the file. Thus the volume size
can vary from the volume size of the object in the scene if the object has for
example been imported applying a ROI.
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CLIPPING TOOL

Clipping plane

lipping objects enable you to render parts of a volumetric/polygo-

nal object transparent independent of the Render Settings of the volu-

metric/polygonal object. This is done by cutting away parts of the
volumetric/polygonal object using a geometric (plane or box) object.

General

Clipping objects can be created either directly from the Object menu or
from the context menus of the 3D window and the Scene Tree (invoke a
context menu with a right mouse click).

A clipping plane can also be created using the Scissors icon at the bottom of
each of the 2D windows or from the 2D windows context menu. In this
case the plane is automatically located at the slice location shown in the 2D
window from which the clipping plane is created.

The transformation and scaling of a clipping object can be reset to its
default values via the Reset function in the context menu.

Multiple clipping objects can be combined to achieve more complex clip-
ping regions.

To share a clipping object between multiple volume/polygon objects, group
these together and define the clipping object for the group.

Defines a planar geometry for clipping. Any parts of the volumetric/polyg-
onal object laying above the plane in the direction of its surface normal will
be clipped.

Tips and tricks

Use the <Ctr[> key in conjunction with any of the modes for finer control.

ROTATE MODE
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Click and draw with the mouse:

Use the /eft mouse button to rotate the clipping plane around its origin.

The middle mouse button will spin the clipping plane around its origin and
the viewing direction.

Release 2.0 myVGL Manual 13-1



Clipping box

CLIPPING TOOL
General

MOVE MODE

Click and draw with the mouse:

Use the /eft mouse button to translate the clipping plane up/down and
left/right relative to the 3D view, i.e. perpendicular to the viewing direc-
tion.

The middle mouse button will translate the clipping plane in/out relative to
the 3D view, i.e. along the viewing direction.

Specifies a box for clipping. Any parts of the volumetric/polygonal object
outside the box will be clipped.

Pressing and holding the left mouse button over any of the yellow handles
on the sides of the clipping box enables you to resize the clipping box inde-
pendently of the rotation/translation mode of the 3D window. Press, hold
and drag in the directions perpendicular to the side to resize the clipping
box.

ROTATION MODE

Click and draw with the mouse:
Use the /eft mouse button to rotate the clipping box around its origin.

The middle mouse button will spin the clipping box around its origin and
the viewing direction.

TRANSLATION MODE

Click and draw with the mouse:

Use the /eft mouse button to translate the clipping box up/down and
left/right relative to the 3D view, i.e. perpendicular to the viewing direc-
tion.

The middle mouse button will translate the clipping box in/out relative to
the 3D view, i.e. along the viewing direction.

Aligned clipping box
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Specifies an object aligned box for clipping. Any parts of the volumet-
ric/polygonal object outside the box will be clipped. The aligned clipping
box can not be rotated or translated nor can it be scaled to be any larger that
the original volumetric object on which it was defined.

A left mouse click will position the mouse over any of the yellow handles
on the sides of the clipping box. Press, hold and drag in the directions per-
pendicular to the side to resize it.
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warning The aligned clipping box is only available for volumetric objects.

Appearance

Opacity

Reset

Boundary

Reset

Status Information

Displays the name of the selected clipping object in green color. If no clip-
ping object is currently selected in the Scene Tree, the text “No clipping
object selected” is displayed in red and all controls are disabled.

General

This tab shows all controls applicable to all types of clipping objects.

Activate the checkbox to invert the region used for clipping. For clipping
planes, inverting the clipping region will swap the sides used for clipping.
For (aligned) clipping boxes, inverting the clipping region will render any-
thing inside the clipping box transparent.

Controls the opacity value of the clipped region. Move the slider to modify
the opacity or enter an opacity value in the edit box. The value will be
clipped to the range [0;1].

The opacity setting is not available for clipped polygon objects.

Resets the rotation, translation and scaling of the selected clipping object to
the default values (Opacity and inversion state are left unchanged).

Aligned Clipping box

This tab is only enabled if an aligned clipping box is selected.

The minimum and maximum values (in voxels) of the clipping region.

Resets the boundary of the aligned clipping box to its default values which
corresponds to the bounding box of the respective sample grid of the vol-
ume.
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TRANSFORM TOOL

he Transform tool is designed to manipulate spatial properties like

position and orientation, and geometric properties like center, scale

and resolution for a selected object. The tool is organized into sev-
eral tab pages in which you inspect and modify the specific properties.

Status information

This section displays information about the current status of the Transform
tool. If a valid object is selected it‘s name is displayed in green color. A
valid object is either a voxel data set, a polygonal model or a region of
interest. The Status information display also gives you a hint if the transform
property tool is deactivated for your current selection in the Scene Tree (e.g.
No object with transformation selected).

Coordinate system

Select a coordinate system from the pull down to inspect and manipulate
values relative to the selected coordinate system.

Position (Pos)

TR N R R R R Y
To modify the position, enter the exact position value in X, y and z coordi-
nates. You may also use the up and down arrows to increase or reduce the
values. Click the Reset button to restore the initial position.

Rotation (Rot)
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Specify the rotation of an object either in Standard or Advanced mode.
Switch between Standard/Advanced mode by clicking the Standard/Advanced
button.

® Standard
The Standard dialog provides you with an interface where you enter incre-
mental rotation values for each axis. Enter the incremental rotation around
the x, y, or z axis or use the up and down arrows to increase or reduce the
rotation values.
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Center

Advanced

The Advanced dialog provides you with an interface where you enter abso-
lute rotation values for the selected object. The absolute rotation is defined
by a normalized vector in 3D space serving as rotational axis and a rotation
angle around this vector.

Enter the x, y or z coordinates to define the rotational axis or use the up and
down arrows to increase or reduce the x, y or z values.

Enter the absolute rotation angle around the rotational axis defined by the
X, y and z values or use the up and down arrows to increase or reduce the
rotation angle.

Press the Reset button to reset the orientation of the selected object to its
original value.

Center

Specify the center of the selected object. By default the origin of an object
is at (Xmax/2, Ymax/2, Zmax/2), where Xmax, Ymax and Zmax describe
the extent of the object’s bounding box.

Enter the x, y or z coordinates of the desired center or use the up and down
arrows to increase or reduce the x, y, or z values.

Press the Reset button to restore the default center values.

The center of an object is important for rotations, as it defines the position
of the axis of rotation.

Resolution

This Option can only be applied to voxel data sets. Specify the size of a
voxel by modifying the resolution values.

Warning

Modifying the resolution will change the geometry of the voxel data set
and therefore invalidate any existing analysis results for this voxel data set.
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Press the Override button to show the Override resolution dialog. Enter the x,
y or z resolution values or use the up and down arrows to increase or reduce
the x, y, or z values.
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olygon rendering is supported by myVGL2.0.
Supported formats (in alphabetical order):

¢ Stereolithography File Format (*.stl, *.STL)
General Stereolithography (STL) files.

® Stereolithography ASCII File Format(*.stl, *.STL)
ASCII coded Stereolithography (STL) files.

® Stereolithography Binary File Format (*.stl, *.STL)
Binary coded Stereolithography (STL) files.

Polygon objects can be assigned separate materials for front and back face.
In addition, polygon objects can be clipped by clipping planes or clipping
boxes (see chapter Clipping tool) and can be illuminated by different light
sources (see chapter Light tool).

Warning Due to restrictions of OpenGL, most systems support only up to six
clipping planes. In this context, every side of a clipping box that actually
clips the object counts as a separate clipping plane.

In the 3D view only the front face of the polygon object is rendered by
default. The material properties for front and back face can be specified
independently. The polygon object can not only be rendered solid, but also
as wireframe or point cloud.

In the 2D view one slice of the polygon object is rendered. The color of the
outline can be chosen.

Status information

Displays the name of the selected polygon object.

General

Preset selection
Save your changes by choosing Save preset from right pull down menu.
With Export preset and Import preset the settings made in the tool can be
saved and loaded into a file. Choose one of the default presets to exclu-
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Render wireframe
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POLYGON RENDERING TOOL
General

sively set one of the following options: Render solid, Render wireframe, Ren-
der point cloud. All changes made in the tool are overwritten by choosing a
preset.

Activate this option to render the triangles of the polygon object.

SHADING MODEL

Choose Flat to show each triangle of the polygon object. The color between
the triangle vertices is not interpolated.

Choose Smooth to get the color of the triangle vertices interpolated. This
results in a much cleaner object surface.

CULL FACE

In the Cull face pull-down menu you specify the face of the polygon object
that is not rendered. Choose Front to render the back face only. Choose Back
to render the front face only. Choose Disabled to render both faces.

The image below shows a polygonal object that is rendered solid.

Activate this option to render the wireframe of the polygon object, i.e. the
lines between the triangle vertices.

Double click the quadratic box to select the line Color. Use the spin box to
specify the Line width in pixels.
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Render point cloud

POLYGON RENDERING TOOL
Material

The image below shows a the wireframe of a polygonal object.

Activate this option to render the point cloud of the polygon object, i.e. tri-
angle vertices.

Double click the quadratic box to select the point Color. Use the spin box to
specify the Point size in pixels.

The image below shows a the point cloud of a polygonal object.
SRR

Material

Assign a material to every face of the polygon object and a color to the out-
line in the 2D view.

Tips and tricks

The ambient and diffuse color of the front face of a certain polygon define
the color of the corresponding icon in the Scene Tree to allow an easy
identification.
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POLYGON RENDERING TOOL
Material

Material face settings

Choose Front face or Back face whether you want to change the Color and
Intensity of the front or back side of the polygon object.

Tips and tricks

The Back face of the polygon object is only relevant if you clip the object or
if you search visually for mesh defects. Switch off rendering the Back face

by choosing Back from the Cull face pull down menu in the Advanced tab to
gain rendering performance.

Color and Intensity

Slice color
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Double click the respective quadratic box to choose the color for the Ambi-
ent, Diffuse or Specular component of the material. Use the spin box to
choose the intensity of the material color component.

The color and intensity of the material defines how much of the light is
reflected from the object’s surface in each of the three components ambi-
ent, diffuse and specular. The Shininess controls the size and brightness of
the highlight of the specular component.

Double click the quadratic box to choose the Color for the outline of the
polygon object in the 2D views.
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LIGHT TOOL

ight sources in myVGL2.0 can be of type directional, point and spot.

Both volume and polygon objects can be illuminated with the

phong shading algorithm. Shadows are supported by software vol-
ume renderers only and have to be activated for each light source.

The light sources can be created by choosing New > and the type of light
source from the context menu of the Scene Tree Tool. Only if selected in the
Scene Tree the light source is shown in the 2D and 3D view and can be
modified there with the mouse:

¢ In the 3D view it can be rotated and moved.

* In the 2D view start and end point can be modified. To initially place a
light source click somewhere in the window and move the mouse into
the light direction while holding down the left mouse button.

Warning

The light object can be modified only if the lock icon in the Scene Tree is
opened for this object.

Preset selection

Type

Status information

Displays the name of the selected light source.

General

Choose Default light to set the default attributes for the light source. This
overwrites all changes in the tool. To save your own changes choose Save
preset from the right pull down menu.

With Export preset and Import preset the attributes of the light source can be
saved and loaded into a file.

Select the type of the light source.

¢ Directional
A light source sending out a parallel bundle of light rays in a particular
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LIGHT TOOL
16
General

direction. The light intensity does not drop with distance. See the figure
below for an example of a Directional light source.

¢ Point
A single point in space sending out light equally in all directions. The
intensity of the light decreases proportional to the square of the distance
to the light source. This is comparable to an infinitely small unshaded
light bulb. See the figure below for an example of a Point light source.

¢ Spot
Similar to a point light but emission is limited to within a cone much like
aregular desk lamp. Thus this light type has an angular setting to define
the size of the cone: The Cutoff Angle and an additional attenuation
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Color and Intensity

LIGHT TOOL

General

Exponent can be set in the Advanced tab.See the figure below for an
example of a Spot light source.

Specify the intensity and color of the light components here: Double click
the quadratic box to select the color of the respective light component.
Enter its intensity into the text field.

¢ Overall
Sets the light intensity globally and affects all three light components:
ambient, diffuse and specular.

Tips and tricks

You can also modify the overall intensity of a selected light source by
moving the scroll wheel while the mouse pointer is over the 3D window.

¢ Ambient
The light component for general illumination.

¢ Diffuse
The light component that comes from one direction and scatters equally
into all directions.

¢ Specular
The light component that comes from a particular direction and bounces
of into a preferred direction. It is responsible for the shininess of a
lighted object.
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Advanced

See the figure below for an illustration of the different light components.

Ambient; 50

Diffuse: 20

Specular: 10

10

Ambient: 20
Diffuse: 50

Specular: 10

10

Ambient: 20
Diffuse: 50
Specular: 100
300

Shadow mode
Switch shadows of the selected light source on or off here. Not all render-
ers support shadows or only for one light source.

Advanced

Attenuation
Point and spot light sources support attenuation. This is the intensity
decrease of the light source along the light direction. The easiest way to
work with it is to use the Constant or Gradient buttons:
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Spot

LIGHT TOOL
Advanced

Constant sets the light source to have no attenuation at all. The Linear and
Quadratic factors are set to 0. The Constant factor is set to 1. This is the
default.

Gradient sets the attenuation so that the half of the intensity decrease of
the light source lies within the 2D view. This intensity is shown by a
dashed circle around the light source and can be modified with the
mouse.

The spot light source supports a Cutoff Angle for its shade. You can either
enter a value in the text box or modify it with the mouse: Use <Ctr/> +
left mouse button on it and move up or down in the 2D view to open or
close the shade.

The Exponent value controls the decrease of the light intensity along the
cone radius. The higher the exponent, the faster the decrease of the light
intensity.
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CAMERA TOOL

Camera Orientation

he 3D view of myVGL is rendered using a virtual camera placed in

the scene together with the volumetric/polygonal data. Various

properties such as camera position, viewing direction and aperture
angle can be controlled using this tool.

General

DEFAULT CAMERA VIEWS.

R R R R Y
The Camera tool includes shortcuts to fourteen default camera views, rela-
tive to the selected coordinate system. They can be used for quick viewing
and generation of reference screenshots. These default views are along the
three major axis (in both directions) as well as from positions along each of
the four diagonals (one position for each corner).

+ . . . .
The ++ button centers the selected object in the 3D view (via a transla-
tion along the screen plane).

The [ button focuses the selected object in the 3D view (via a transla-
tion along the viewing direction).

POSITION

Display and manipulate the position of the camera (in the current coordi-
nate system) here.

FOCAL POINT

Display and manipulate the position to which the camera is focused here.

The view direction can be obtained by subtracting the Position coordinates
from the Focal point coordinates (and normalizing the result).

UP VECTOR

f1r1rr N INLINRRNRORRRBRRORORRRORORORORIRRIRIRIRRRRIRIRIRRRRILLDY
Specifies the vertical orientation of the camera, that means it implicitly sets
the axial rotation of the camera relative to the view direction.
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Projection mode

View Angle

Image mode
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CAMERA TOOL
Stereo

PERSPECTIVE

Renders the 3D models as seen by a single human eye: Spatial forshorten-
ing and apparent size as a function of distance is taken into account. That
means that objects look smaller the further away they are.

PARALLEL

Renders the 3D models without perspective correction such that the rela-
tive proportions of an object are maintained independent of distance.

STEREO-PERSPECTIVE

Renders a pair of perspective images of the scene. The camera positions of
the two images are slightly offset to mimic for example the offset between
the right and left eye. When viewed correctly the image pair will create the
perception of observing the objects in the scene in three dimensions.

Stereo viewing requires additional hardware either in the form of special
glasses or dedicated displays.

Specifies the vertical viewing angle (in degrees) of the camera.

Stereo

This tab is only active when Projection mode: Stereo-Perspective is chosen.

ANAGLYPH IMAGE RED-GREEN, RED-BLUE, RED-CYAN

Encodes the left and right eye images into the respective color channels of
the display (anachrome stereo). To view the result in stereo, a pair of (inex-
pensive) 2 color glasses are required.

INTERLACED

Encodes the left and right eye images into one image where either the rows
or columns are alternatively taken from the left or right image. This mode
requires special display video formats and/or special glasses.

LEFT IMAGE ONLY

Displays the left eye image only.
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Settings mode

Eye distance

Display distance

Focal depth

Scene Zoom

CAMERA TOOL

Stereo

RIGHT IMAGE ONLY

Displays the right eye image only.

OPENGL

Alternates between showing the left and right eye images (active stereo).
This mode requires additional hardware for stereo viewing (stereo glasses
and a synchronization transmitter).

The degree of sterco perception depends on the relative scale of such
parameters as eye, focal and image plane distances relative to the distance
to the viewed object and its size. By tuning these parameters to the specific
scene the 3D experience can be optimized.

FIXED FOCAL DEPTH

Lets you vary the focal distance, but uses fixed scaling.

FIXED VIEWER-SCENE SCALING

Assumes an infinite focal distance and lets you scale the viewing parame-
ters relative to the Scene (Scene Zoom).

Sets the interocular (eye) distance.

Sets the distance between the eyes/cameras and the 2D image plane.

Set the distance at which the eyes are focused, i.e the distance at which the
view vectors from each eye/camera cross. Only available in the Fixed Focal
Depth mode.

Sets the scale between the viewing parameters and the Scene. Only avail-
able in the Fixed viewer-scene scaling mode.
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TEXT OVERLAY EDITOR

Preset Selection

he Text overlay editor is designed to decorate 2D windows and the 3D

window with customizable text overlays. The text overlays will

supply you with additional information (e.g. current slice position,
the window name or even DICOM tags) about the specific 2D/3D view.
This feature is useful for reporting/documentation purposes (see also Save
image(s)... in chapter File menu on page 3-9 and Save AVI/image stack ...
in chapter File menu on page 3-10).

Configure the text overlay via Window > Text overlay editor or by right-click-
ing into the 3D or 2D windows and choosing Text overlay > Configure...

The dialog is organized into two tab pages, the Slice views and the Scene
view tab page. Both pages are structured identically. Click the Font settings
button to show the preferences available for fonts. Click the Ok button to
apply the current settings and close the editor. Click the Cancel button to
close the dialog without applying any changes. Click the Apply button to get
a preview of the current settings.

Slice Views (and Scene View)

On each tab page you modify and inspect your text overlays.

In the Preset selection section you manage text overlay presets. Select a pre-
set from the pull down to apply it to the current text overlay settings.

Save

Click the Save button to execute the Save preset dialog. Enter a name for
the preset or choose an entry from the pull down and click the Save button
to store the current text overlay settings.Click the Cancel button to abort the
save process

Remove
Click the Remove button to remove a preset from the pull down preset list.

Reset
Click the Reset button to reset any modifications made on the active preset.
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Text labels

18-2  myVGL Manual

TEXT OVERLAY EDITOR
Available default text labels:

The Text labels section contains the currently available text labels. Select
either predefined text labels or create custom text labels. The Available text
labels section is a table containing the currently available text labels. The
Selected text labels section is a table containing the currently selected text
labels. Select an entry from the Available text labels table and click the > but-
ton to add an entry to the Selected text labels table. Select an entry from the
Selected text labels table and click the < button to remove the entry from the
Selected text labels table.

Available default text labels:

The following text labels are available by default.

<CoordinateSystem>
Displays the name of the currently active coordinate system for the respec-
tive window.

<SlicePosition>
Displays the current slice position (only available for 2D windows)

<ViewZoom>
Displays the current zoom factor (only available for 2D windows)

<WindowName>

Displays the name of the window. The name indicates the window type,
e.g., Top, Front or Back refers to a 2D window, whereas Scene refers to a 3D
window.

<PatientIlD>
Displays the PatienID DICOM tag (only available for DICOM data sets).

<PatientName>
Displays the PatientName DICOM tag (only available for DICOM data
sets).

<PixelSize>
Displays the size of a pixel respective to the currently selected application
unit.

<SerialNumber>
Displays the SerialNumber DICOM tag (only available for DICOM data
sets)

<StudyDescription>
Displays the StudyDescription DICOM tag (only available for DICOM
data sets)
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Preview

TEXT OVERLAY EDITOR
Available default text labels:

Ex: <StudyIlD>
Displays the StudyID DICOM tag (only available for DICOM data sets)

Se: <StudyNumber>
Displays the StudyNumber DICOM tag (only available for DICOM data
sets)

<CustomLogo>

Displays your custom logo. Drag this entry into the Selected text labels sec-
tion and double-click it to show the Select logo image dialog. In the dialog
you specify the location of your custom logo.

<CustomText>
Displays your custom text. Drag this entry into the Selected text labels sec-
tion and double-click it to modify its text.

The Preview area shows eight boxes in which you can place the selected
text labels. The boxes indicate where the text labels will be positioned
inside either the 2D or the 3D window. You can insert multiple text labels
in each box.
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Available default text labels:
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MEASUREMENTS MENU

he Measurements menu of VGStudio MAX 2.0 provides means for

coordinate measuring, i.e. enables you to fit reference objects to

your calibrated volumetric or geometric data and define measure-
ments on the data based on the reference objects.

Coordinate measurement (CM) is an optional add-on module for VGStudio
MAX 2.0. It is not available for myVGL. However, if a project contains coor-
dinate measurements, those measurements are available in myVGL.

If you are interested in more extensive functionality than the one offered by
myVGL, you have the chance to evaluate our other products, VGStudio 2.0 or
VGStudio MAX 2.0:

www.volumegraphics.com/products/evaluation/form.html
For further questions about our product portfolio, please contact
sales@volumegraphics.com

In myVGL, there are seven types of Reference Objects (see description
below), an arbitrary number of which can be shown for any calibrated vol-
umetric or geometric object. In the Scene Tree, Reference objects are listed in
the Coordinate Measurement > Reference Objects section.

Based on existing reference objects, features show measured positions, dis-
tances, angles and radii.

Features rely on the definition of distinct coordinate systems.

Point

A reference point was fitted to the object based on one or more fit points. A
point’s only geometric property is its position.

Line

f1r1rr N INLINRRNRORRRBRRORORRRORORORORIRRIRIRIRRRRIRIRIRRRRILLDY
A reference line was fitted to the object based on two or more fit points. A
line’s geometric properties are its position and direction.
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MEASUREMENTS MENU
Circle

Circle

TR R R R R R Y
A reference circle was fitted to the object based on three or more fit points.
A circle’s geometric properties are its center position, its orientation nor-
mal and its radius.

Pplane

ftfrrr PR NNRRRRRRNORORRRBRRORORRRORIRORIRIRIRIRIRRRRRIRIRRRERRERLLDY
A reference plane was fitted to the object based on three or more fit points.
A plane’s geometric properties are its center position and orientation nor-
mal.

Sphere

ftfrrr PR NNRRRRRRNORORRRBRRORORRRORIRORIRIRIRIRIRRRRRIRIRRRERRERLLDY
A reference sphere was fitted to the object based on four or more fit points.
A sphere’s geometric properties are its center position and radius.

Cylinder

A reference cylinder was fitted to the object based on three or more fit
points. A cylinder’s geometric properties are its center position, its direc-
tion and its radius.

Cone

A reference cone was fitted to the object based on three or more fit points.
A cone’s geometric properties are its center position, its direction, its center
radius and its conicity angle.

Dialog: Reference object properties

Warning

In myVGL, all grayed settings are displayed for informational value only.
Editing those settings or making new measurements is only possible using
VGStudio MAX 2.0 with the Measurements module installed.
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To show the properties of a reference object either double click the refer-
ence object in the Scene Tree or select the Properties option from the Scene
Tree context menu.
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MEASUREMENTS MENU
Dialog: Reference object properties

warning Be aware that all geometric properties like positions and directions will be

displayed with respect to the currently selected coordinate system!

Properties

Shows geometric and status properties of the reference object.

DESCRIPTION

The object’s type and name. The name can be edited.

CONSTRUCTION METHOD

Information about how this object was defined:
* [Least-squares/Minimum-zone] fitted
» Result of [intersection/combination/projection/...]

* Manually defined reference object

SIZE STATUS

TR R R R R R R R R N Y
Status information about how the actual size of the reference object is
determined. In most cases, the size of fitted reference objects depends on
all its fit points, and the size of intersected/combined objects depends on
their source objects. Other sizing methods can be forced by Measurements >
Resize reference objects.

FIT STATUS

Status information about the last fitting process of the reference object:

¢ Valid: Successfully fitted to current calibrated material
Last fitting or refitting process succeeded without problems. Reference
object is synchronized with current situation.

¢ Invalid: Not synchronized with current situation (calibration change?)
The underlying data (voxel data, calibration material, polygon data) has
changed since the last fitting process.

¢ Invalid: Automatic refit failed
Last refitting process (due to resolution adjustment or template import)
failed, most likely because too few fit points could be adjusted to the
new underlying surface.

¢ Valid: Isosurface not found for iteration >0, but previous result could be taken
Last (iterative) refitting process (due to resolution adjustment or
template import) did not succeed completely, but a valid result could still
be taken from a previous iteration.
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Fit points

Histogram
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MEASUREMENTS MENU
Dialog: Reference object properties

For derived reference objects, i.e. manipulation results, the status informa-
tion has similar meanings, but it refers to the status of the source objects: if
one of the source objects has a warning or error status, this status will be
repeated for the derived object.

POSITION / RADIUS / CONICITY / DIRECTION / NORMAL

R N N R
Geometric parameters. Position always denotes the center of the object.
Direction and normal vectors are normalized to unit length. For cones, the
radius at the center position is given.

DEVIATIONS

TR RN AR R R R R R R Y
Statistic measures of the fit point distribution. Peak/valley deviations
denote the maximum positive/negative distances of any fit point to the ref-
erence object’s surface. The form deviation equals the sum of peak and val-
ley.

Notes:

» For circles, the deviation is the distance to the actual circle outline, not
merely the circle’s plane.

* For lines that were initially specified in a 2D window, the 2D orientation
at fitting time is stored and used to provide a “left of line / right of line”
distinction for signed distances (like for all other reference object types
except the point). If a line has no orientation information, all distances,
will be positive (valley deviation zero per definition).

» The deviation signs are chosen such that positive deviations indicate
points outside the calibrated material.

Shows a list of the fit points used to calculate the properties of the reference
object. The list includes information such as the position, deviation and
gray value for each point. The list can be sorted according to each property
by selecting the property column. Points can be visualized individually or
in groups by selecting them in the list.

Shows the histogram plot of the fit point count against deviation. The col-
oring is determined by the reference deviation in the Colors section.

BINNING

[ IO I I BN B DN D RO B RO I DN B B BN NN DN D BN BN BN DN DO B BN RN NN DN BN BN BN BN DN DN BN NN RN NN DN DO BN BN BN NN BN BN BN BN NN BN B )
In the Binning pull-down menu, you can choose between no binning and a
binning according to the sections of the color bar.
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Cumulated

MEASUREMENTS MENU
CM Reporting

Shows the accumulated percentile of fitpoints against their deviation. The
accumulated statistics can be shown for fitpoints with either a positive or
negative deviation or for all fitpoints as a function of their absolute numer-
ical deviation by selecting the corresponding entry in the Cumulation box.
By moving the green cross-hair in the diagram the percentage of points
within a given deviation (or alternatively the max deviation for a given per-
centage) can be obtained. The latter is also possible by directly typing in
the values in the Deviation or Percentage dialogs.

Tips and tricks

In contrast to the other properties sections, the Histogram and Cumulated
graphs are also available when multiple reference objects are selected.
They will then reflect the union of both sets of fit points.

Colors

Sets the interval width and colors used in the histogram plot and for the
color-coded visible fit points in 2D and 3D. By default the interval width is
in units of the automatically determined standard deviation. This is the
standard deviation of all selected reference objects or (if no objects are
selected) all reference objects found in the scene.

By unchecking the auto box a custom value can be specified. To change the
color used for a specific interval range double click the corresponding color
bar to launch the color selection tool.

CM Reporting

Warning

In myVGL, all grayed settings are displayed for informational value only.
Editing those settings or making new measurements is only possible using
VGStudio MAX 2.0 with the Measurements module installed.

Use the CM reporting dialog to view, edit and print detailed information
about reference objects and features. The dialog will show reference
objects and features connected to a single volume/polygon, which depends
on the current Scene Tree selection. The name of the current volume/poly-
gon is shown in the caption of the dialog.

Tips and tricks

myVGL will automatically show the CM reporting dialog when you double-
click on any CM feature in the Scene Tree.
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MEASUREMENTS MENU
CM Reporting

The Features and Reference objects pages basically employ myVGL’s stan-
dard reporting table functionality:

TABLE SELECTION

Select one or more table rows by left-clicking while holding <C#r/> or
<Shift> or by using the up-down arrow-keys while holding <Shift>.
Selecting rows will also select corresponding objects in the Scene Tree.

EDITING

Double-click into text cells with white background to edit their contents
(e.g. object name). Grayed-out cells are not editable.

SCREENSHOTS

Use the Screenshots section below the table to capture images from one of
the 2D or 3D views for the currently selected item in the table. Only avail-
able if exactly one row is selected.

You can provide a description for every captured image by clicking the
default <no description> text.

Delete existing screenshots by pressing <Del>.

CONTEXT MENU

Right-click anywhere in the table to bring up the table’s context menu:
* Columns: Toggle the visibility of any available column

* Store current visibilities and widths as default settings: Store column visibility
and order on disk to remember them for the next time you restart myVGL .

+ Remove entries: Removes a complete row from the table.

* Export as CSV: Exports the table values as CSV (Comma Separated
Values) list.

* Copy to clipboard: Copy the selected rows (and the table header texts) into
the system’s clipboard. The clipboard information is provided both as
plain text and a rich-text table, so when pasting into a rich-text-capable
application like a wordprocessor, you will see a proper table with cells
borders and bold headers.

COLUMN-ORDER

Left-click on any table header on top of each column while holding
<Ctrl>. You can now move the column left or right to another place.
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MEASUREMENTS MENU
CM Reporting

ROW-SORTING

N R R Y
Left-click on any table header on top of each column to sort the entire table
according to this column. Click again to reverse the sort order. The current
sort order is indicated by an arrow inside the column header.

SPECIAL COLUMNS

In addition to text cells, some columns contain combo-boxes for selecting
special options.

Lists all existing reference objects and their properties here.

As each feature is defined in a distinct coordinate system, lengths and posi-
tions displayed in the table do not refer to the currently selected coordinate
system, but to the coordinate system of the feature itself!

FEATURE LIST

Name
The name of the feature. Column is editable.

Type
The type of the feature. Can be one of the following:

¢ Distance
Default distance measuring method. The distance line between the
center positions of the two reference objects is calculated.

¢ Distance (mid perpendicular)
Reference object A is considered as finite, while reference object B is
considered as infinitely extended. The mean between minimum and
maximum distance (orthogonal to reference object A) between the two
objects is determined.

¢ Distance (min perpendicular)
Reference object A is considered as finite, while reference object B is
considered as infinitely extended. The minimum distance (orthogonal to
reference object A) between the two objects is determined.

¢ Distance (max perpendicular)
Reference object A is considered as finite, while reference object B is
considered as infinitely extended. The maximum distance (orthogonal to
reference object A) between the two objects is determined.

¢ Distance (min finite)
Both reference objects are considered as finite. The minimum distance
between the two objects is determined.
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CM Reporting

Distance (max finite)
Both reference objects are considered as finite. The maximum distance
between the two objects is determined.

Distance (min infinite)

Both reference objects are considered as infinitely extended. The
minimum distance between the infinite objects is determined if they are
not intersecting.

Distance (min)

Reference object A is considered as finite, while reference object B is
considered as infinitely extended. The minimum distance (orthogonal to
reference object B) between the two objects is determined.

Distance (centroid)

The distance between the geometrical center of all fit points used to fit
reference object A and object B is determined. Please note that the
geometrical center of an object is calculated with respect to the fit point
coordinates only. It is not calculated as the geometrical center of the
fitted reference object A or B.

Angle
Angle between two reference objects. Angles can be measured between
line and line, line and plane or plane and plane.

Position
Determines the position of a single reference object in the current
Coordinate system, that is its distance to the origin.

Radius

Radius of a single reference object. Radii can be measured for circles,
spheres, cylinders and cones. For spheres and cones, the position of the
radius measurement, which is determined at creation time, is relevant.
For circles, cylinders and cones, radius features are only well-defined if
their coordinate system is aligned to the measured object’s axis/normal.

Diameter
Diameter of a single reference object. Equals twice the Radius.

Projection
Available for Distance, Position and Angle features. These can be projected
along one or two spatial dimensions:

A dX (or dY or dZ) Distance/Position feature refers to the x (or y or z)-compo-
nent of the measured distance-line only.

A dXY (or dXZ or dYZ) Distance/Position feature refers to the distance-line
projected onto the according plane.

If no projection is desired, use a dXYZ feature.
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Angles cannot be projected onto a single axis. For Angle features, only dXY,
dXZ, dYZ and dXYZ projections are available.

Projection directions are always referring to the axes of the feature’s Coordi-
nate system.

View

Distance or position features with dX, dY or dZ Projection can exist in two
possible orientations (a dX-feature can show up in a Top/Bottom (XY)-slice
or a Front/Back (XZ)-slice). The View determines this orientation.

Coordinate system
Specifies the coordinate system in which the feature is defined.

Source A [ Source B

The reference object(s) used to define this feature. For position, radius and
diameter features, only Source A is present. Distance and angle features
have both source objects.

Relative

Available and relevant for projected (non-dXYZ) distance features only. In
relative mode, the feature does not visualize the measured distances
directly, but rather visualizes the distances to the coordinate system origin
for each endpoint.

The Relative setting has no effect on the numerical value of the feature.

Depth

Available and relevant for projected (non-dXYZ) features only. The feature
depth determines the position in which the projected feature is visualized in
3D. The feature’s orientation being determined by its Projection and View,
there is still one degree of freedom when displaying it in a 3D view. When
dragging a feature in a 2D view, the initial depth is determined from the
slice position in which the feature was dragged out. The depth can later be
changed freely.

Snap

Available and relevant for projected (non-dXYZ) distance features only.
The snap fixes the feature’s Depth to either the start- or the end-point of the
distance measurement (Begin/End), or retains the given depth (Free).

Value

The feature’s numerical value. For angle features, the value is displayed in
the current angle unit, for all other types of features it is displayed in the
current length unit.

Nominal

The desired nominal value for the feature. This cell is editable. Together
with the Tolerance neg./pos. settings, myVGL will determine whether the fea-
ture is inside the prescribed tolerance band and set the features status
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accordingly. If either nominal value or tolerances are not set, the tolerance
test is omitted.

Tolerance neg. / Tolerance pos.

The allowed tolerance of the feature’s actual Value towards the given Nomi-
nal value. This column is editable. After initially entering one of the
neg./pos. tolerance values, the other value will be set to the same value,
providing a symmetric tolerance band. Afterwards, you can change the
positive and negative tolerances independently.

Status
Status information about the feature:

¢ Ok
No errors or warnings.
Feature and source objects are well defined.
Tolerance band is present and feature lies within.

¢ Ok, but no tolerance settings
Feature and source objects are well defined, but no tolerance band is
given. The feature value is not tested against any allowed range.

¢ Out of tolerance band
Feature and source objects are well defined, but the feature’s actual
value lies outside the prescribed tolerance band.

¢ Invalid measurement
Although the source objects are valid, measurement of the desired
feature is not possible. This can happen in case of undefined
measurement modes (such as a centroid-distance between objects
without fit points).

* Invalid source object(s)
The feature’s source objects indicate an error status.

* Inconsistent source object(s)
Feature could be measured, but its source objects are indicate a warning
status. Probably the source objects need to be refitted, or the last refit
succeeded only partially.

Image

Choose On if you want a detailed 2D-image and feature description to be
generated on a separate page of the report. myVGL will automatically create
a suitable slice image for the feature.

Note that the generated image will only contain the reported feature, its
source reference objects and its parent volume/polygon. All other reference
objects, features, analyses etc. will be hidden. The 2D slice position used
for taking the image is determined by the feature’s position. The zoom fac-
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tor of the image is chosen such that the entire parent volume/polygon is vis-
ible. For all features with a preferred orientation (namely all except dXYZ-
positions and -distances), a single image in this orientation will be created.

Otherwise an orthographic projection with three orthogonal views relative

to the feature’s coordinate system is generated.

Captures
The number of images captured for this objects in the Screenshots section.

Lists all existing reference objects and their properties.

Warning

All geometric properties like positions and directions will be displayed and
reported with respect to the currently selected coordinate system and the
currently selected display unit.

For possible details on reference object properties refer to Dialog: Refer-
ence object properties on page 19-2.

REFERENCE OBJECT LIST

Name
The name of the reference objects. This column is editable.

Type
The object’s type. Either point, line, circle, plane, sphere, cylinder, cone.

Position X / Position Y / Position Z
The object’s position in physical length units.

Direction X / Direction Y / Direction Z
The object’s normalized direction vector (available for line, cylinder, cone).

Normal X / Normal Y / Normal Z
The object’s normalized normal vector (available for circle, plane).

Radius

The object’s radius (available for circle, sphere, cylinder, cone).
Conicity

The object’s conicity in angle units (available for cone).
Form / Peak / Valley

The object’s fit point deviation measures (available for fitted reference
objects only).

Construction method
The object’s construction method (see Properties on page 19-3).
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Image

Choose an option other than None if you want a detailed 2D-image and
object description to be generated on a separate page of the report. The
selected option determines the type of image myVGL will automatically cre-
ate for the object. Orthographic projection will produce three orthogonal
views, the Top, Bottom, Left, Right, Front, Back options each produce a single
2D view in the specified orientation.

The image orientation is relative to the currently selected coordinate sys-
tem!

Note that the generated image will only contain the reported reference
object and its parent volume/polygon. All other reference objects, features,
analyses etc. will be hidden. The reference object is always shown without
visible fit points and in a “highlighted” visual state. The 2D slice position
used for taking the image is determined by the reference object’s position.
The zoom factor of the image is chosen such that the entire parent vol-
ume/polygon is visible.

Zoomed image

The zoom view is almost identical to the Detail view, but will generate an
image that is additionally zoomed in by a Zoom factor prescribed on the
Report page.

Histogram image

Choose whether to include the fit point histogram and/or the cumulated his-
togram in the reporting details for this reference object (available for fitted
reference objects only).

Captures
The number of images captured for this objects in the Screenshots section.

The Capture images tab allows to take screenshots from the selected work-
space widget. The captured images are listed separately within the final
report apart from screenshots created in the Features or Reference objects
section.

The Report page lets you specify the content and layout of the final report.

Use the Print button to show the Print preview dialog. There, use the Previous
page and Next page buttons to navigate through the report preview. Click the
Layout button to bring up the Print layout dialog. There you can specify the
orientation (Portrait or Landscape), the paper size and the desired output
resolution.

Use the Save button to save the report to disk in the desired format:
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¢ Rich Text Format:
Save the entire report with tables and images as an .rtf-document.

¢ HTML Format:
Save the entire report with tables and images as an .html-document.

* Comma Separated Values:
Save only the table(s) without images and further formatting as a .csv-
file.

REPORT SECTIONS

Choose whether the report should contain the list of Features and/or Refer-
ence objects.

DETAIL IMAGES SETTINGS

Use these settings to change the appearance of the detail images you speci-
fied in the Features and/or Reference objects tables. Zoom factor sets the zoom
level for all Detail zoom view images in the respective tables. By enabling
the Manual check box you can change Color mode and or the Background color
of the various workspace widget screenshots created within the analysis.

LOGO

Specify an image file that should be utilized as a logo within the report.

CELLS

Each report page will contain a set of user defined cells. These cells are
part of the report layout and their content is customizable. Simply click on
a cell and select an attribute from the pull down. Either assign the attribute
to the Cell title or to the Cell content. The Cell title is a textual description of
the cell content. The Cell content defines what shall be displayed within the
cell. You can append attributes to previous attributes by clicking the assign
button again.
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he nominal/actual comparison tool is designed to compare voxel

data sets with CAD polygonal models or voxel data sets with

voxel data sets. As a result of such an analysis the user will get a
detailed report about the detected deviations and a false color coded data
set for documentation purposes.

Nominal/actual comparison is an optional add-on module for VGStudlo MAX
2.0. It is not available for myVGL. However, if a project contains an analy-
sis, the result of this analysis is available in myVGL.

If you are interested in more extensive functionality than the one offered by
myVGL, you have the chance to evaluate our other products, VGStudio 2.0 or
VGStudio MAX 2.0:

www.volumegraphics.com/products/evaluation/form. html
For further questions about our product portfolio, please contact
sales@volumegraphics.com

The nominal/actual comparison dialog consists of several pages in which
you can inspect the nominal/actual analysis result. Each page shares in its
display a Close button which closes the dialog without performing an anal-
ysis. A status bar at the bottom of each page signals the current status of the
analysis. The status can either be

* ready to go

Everything needed for the analysis is available.

* analysis is up to date

The current analysis result is valid.

* analysis update required

Some user action led to an invalidation of the current analysis result.

* object is not calibrated

No calibration information is available for actual object.

* no valid reference object

The nominal object is either missing or (if it is a volume data set) not prop-
erly calibrated.
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Settings

Settings

Warning

In myVGL, all grayed settings are displayed for informational value only.
Editing those settings or running the analysis is only possible using
VGStudio MAX 2.0 with the Nominal/Actual comparison module installed.

Preset Selection

Select or remove a user defined preset from the preset selection pull down.
Any parameter set applied within the Settings page can be saved as a user
defined preset. Presets can be deleted, exported or imported via the respec-
tive buttons.

Calculation parameters

Options

LUT
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In the Nominal/Reference object pull-down menu select the nominal object
against which the actual object will be compared.

The surface of the nominal object can be either above or below the surface
of the actual object within a certain distance. Specify the Max. distance to
determine how far away from one surface the other will be sought. Dis-

tances exceeding the specified Max. distance value will be marked as unde-
fined.

The Skip X, Skip Y and Skip Z parameters can be used to skip voxels and thus
reduce the time to perform the analysis at the cost of lower accuracy.

If the surface of the nominal object is below the surface of the actual object
the variance between the two surfaces is positive. If the surface of the nom-
inal object is above the surface of the actual object the variance is negative.
If both surfaces match there is zero variance. By enabling the swap distance
signs option, you invert the variance value. The variance must be between
+/- Max. distance. Variances above or below +/- Max. distance are marked as
undefined which is represented through the special values +/- inf.

Colors

Here you can specify a color coding scheme used for the representation of
the analysis result mask.

Gives you a preview of how the color lookup table is partitioned into color
sections.
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Colors

In the Sections element the appearance of each color section is defined. Cre-
ate smooth will generate one color section. Clicking the button will show
the Create smooth table dialog. Define the variance range by entering from
and to values.

Create stepped generates a set of color sections. Clicking the button will
show the Create stepped table dialog. Define the variance range by entering
from, to and step values.

Clicking Auto scale fits the LUT to the range of analysis results.

There are two special color sections defining the color value for variances
above and below the specified Max. Distance. The variances above the posi-
tive Max. Thickness are marked as +inf, the variances below the negative
Max. Thickness are marked as -inf.

Each generated color section can be modified individually. In the Sections
table simply click onto an entry to modify its value. From and To define the
start and end values of the color sections. Type switches between the color-
ing schemes Constant, Gradient, Rainbow and Reverse Rainbow. Detail lets you
modify the appearance of the selected Type color scheme. Right-clicking
onto a color section shows a context menu with the options split and merge.
Splitting a color section divides it up into two new color sections where
each represents half of the original section. Merging several color sections
results into a single color section. Only consecutive intervals can be
merged.

Variance values outside the specified Max. Distance value (see Calculation
parameters on page 20-2) are coded with specific color values. Select the
Yes option from the Clamp outside distances pull down to map the color of
these variances to the one specified in the Clamp colors section on the Colors

page.

Tips and tricks

Use this option if you have several nominal/actual analyses with different
Max. Thickness values. In this case, every analysis shares a common LUT,
whose +/- inf values are specified by the analysis with the largest Max.
Thickness. This might obscure the variance values of analyses with smaller
Max. Thickness values.

By choosing Yes or No for Show 3D result overlay or Show 2D result overlay
you determine whether the color coded result is visible in the 3D and 2D
views respectively. If the comparison has been performed, switching these
settings will be of immediate effect in the views.
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Tickmarks on color

Preset selection

Type

Binning

Context menu
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Histogram

Select a color for the clamped variance values by clicking on the Negative
and/or Positive labeled color chooser (see Options on page 20-3).

bar

If Auto tickmarks is enabled, equidistant tick marks are produced for the
color bars. If Auto tickmarks is disabled, tick marks appear only at the color
section boundaries.

Here you can load, save, delete, import and export LUT presets.

When saving a LUT, you can choose if you want to save an Absolute Preset,
i.e. a preset that maps colors to absolute variance. If the checkbox is not
activated, colors are saved relative to the range of the analysis.

Histogram

This tab shows a histogram of the calculated deviations over the entire ana-
lyzed surface of the actual object. The histogram bars are colored accord-
ing to the current Colors settings.

Histograms of the Type: Point count are based upon a finite number of tested
positions on the actual object’s surface. If you switch to Type: Surface, the
histogram is calculated with regard to the physical surface covered by each
test position. The label of the y-axis will adjust accordingly. This switch is
significant for strongly anisotropic data sets where the mapping of probed
positions to their covered surface is recommended.

In the Binning pull-down menu, you can choose between no binning and a
binning according to the sections of the color bar.

Right-click the histogram area to bring up a context menu offering the fol-
lowing options:

¢ Copy to clipboard
Copies a screenshot of the histogram to the system clipboard.

¢ Show grid lines X/Y
Toggles the display of dashed indicator lines for the respective axis.

Release 2.0



Type

Cumulation

NOMINAL/ACTUAL COMPARISON MODULE
Cumulated

¢ Reset zoom
Zooms the entire histogram to the current window size.

Cumulated

This tab displays the cumulated percentage relative of deviations. It is
derived from the Histogram data. You can use the Cumulated curve to
answers questions like “How many percent of the analyzed surface differ
less than x mm from the nominal value?” or, conversely, “What is the
smallest deviation that ninety percent of the analyzed surface do not
exceed?".

The Type pull-down menu is the same as in Histogram tab. See Histogram
on page 20-4 for more details.

Cumulation does not make sense for mixed positive and negative devia-
tions. Thus, you can choose either a Cumulation of Absolute deviations, or
restrict the cumulation to Only positive or Only negative deviations. The label
of the x-axis will adjust accordingly.

Deviation / Percentage

Context menu

The Deviation and Percentage controls show the cumulated percentage value
below a certain deviation. They are synchronized with the green indicator
lines in the graphical view. You can enter a desired reference deviation or
percentage in the controls or drag the indicator lines with the mouse to
change the current position.

Right-click within the graph to bring up a context menu offering the fol-
lowing options:

¢ Copy to clipboard
Copies a screenshot of the graph to the system clipboard.

¢ Show grid lines X/Y
Toggles the display of dashed indicator lines for the respective axis.

* Reset zoom
Zooms the entire histogram to the current window size.
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General table features

General table features

Right click anywhere into the Annotations table to show its context menu.
The menu contains the following options:

Columns
Here you toggle the visibility status of each column by enabling / disabling
the respective checkbox.

Save as default column layout

Any modifications applied to the table e.g. changing the sorting order of a
column, enabling / disabling of columns or changing the order in which
each column appears can be saved as default column layout. This layout
will be active until you selected Original column layout.

Original column layout
Restores the original table layout and discards any modifications applied
by the user.

Copy to clipboard
Copies the table into the clipboard.

Export as CSV ...
Exports the table values as CSV (Comma Separated Values) list.

Remove entries
Removes a complete row from the table

To change the order in which each column appears in the table press
<Ctrl> and left click the desired column header. Keep the <Ctr/> key
pressed and drag the mouse over the available column headers until the
new position is reached. Release the mouse button to insert the column at
its new position.

Annotations

frrrrrrrrrrrrrNNNNNRNNRRNRORORNRNORONORORORNRORORRORORRORRRORRRRRREEOLN
The Annotations table lists every annotation created for the selected analy-
sis. Here you can see or edit information about the annotations.

The Annotations table lists every annotation created for the selected nomi-
nal/actual analysis. Here you can inspect information supplied by the anno-
tations or edit annotations properties.

To create an annotation select the desired nominal/actual analysis within
the Scene Tree and click the right mouse button to show the analysis con-
text menu. Select New > Analysis annotation and click into any 2D window or
the 3D window to position the annotation.
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The annotation is designed as a movable label displaying informations
about the current analysis. A nominal/actual annotation contains the anno-
tation name, the current Variance (Var), the tolerance values specified via
Tolerance from and Tolerance to and the position of the annotation.

The Variance value is color coded. The green color signalizes an available
Variance value for the current position and the current tolerance values. The
yellow color signalizes that for the current annotation position there is no
Variance value available. This happens if the annotation is moved outside
the nominal/actual result area.The red color signalizes that the Variance
value at the current annotation position is not inside the specified tolerance
interval.

To minimize/maximize the annotation double-click anywhere inside the
annotation.

Furthermore, you can arrange all annotations automatically by right-click-
ing within the respective window and choosing Annotations > Arrange.

The individual columns within the nominal/actual‘s Annotations table are:

* Name

The name of the annotation.

* in Comparison

The name of the Nominal/Actual comparison the annotation belongs to.

« Pos (X,Y, 2)

Position of the annotation.

* Variance

The nominal/actual variance of the analyzed voxel set at the given annota-
tion position.

+ Tolerance from/to

The maximum nominal/actual deviation for the respective annotation.

» Description

Enter a description of the annotation used for reporting.

* Detail view

Select a view mode for reporting. Either choose one of the six view direc-
tions (top, bottom, front, back, right or left) or choose orthographic projection.

* Detail zoom view

Select a zoomed Detail view for reporting.

* Images

Displays the amount of images generated with the Capture from function.
Below the Annotations table is an area reserved for screenshots. To capture
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Capture images

a screenshot first select a view from the pull down, then click the Capture
from button. Each screenshot will be displayed in the area above. The
screenshots can be chosen to appear in the final report. You can specify a
name for the image by clicking the <no description> label twice.

Capture images

The Capture images page allows to take screenshots from the selected
workspace widget. The captured images are listed separately within the
final report apart from screenshots created in the Annotations section.

Report

The Report page lets you specify the content and the layout of the final
report. Either save the report as .rtf (Rich Text Format) or .html document
by clicking the Save button, or print it by clicking the Print button. The Print
button will show you a Print preview dialog. Use the Previous page and Next
page button to navigate through the report preview. Click the Layout button
to bring up the Print layout dialog. There you specify the orientation (Portrait
or Landscape), the paper size and the resolution.

Select which sections of the analysis should be included or excluded from
the report be either enabling or disabling the corresponding checkboxes
Settings, Annotations, Deviation histogram or Cumulated histogram.

Detail images settings

Logo

Cells
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Use these settings to change the appearance of the detail images you speci-
fied in the Annotations table. Zoom factor sets the zoom level for the Detail
zoom view images in the respective tables. By enabling the Manual check
box you can change Color mode and or the Background color of the various
workspace widget screenshots created within the analysis.

Specify an image file that should be utilized as a logo within the report.

Each report page will contain a set of user defined cells. These cells are
part of the report layout and their content is customizable. Simply click on
a cell and select an attribute from the pull down. Either assign the attribute
to the Cell title or to the Cell content. The Cell title is a textual description of
the cell content. The Cell content defines what shall be displayed within the
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Report

cell. You can append attributes to previous attributes by clicking the assign

button again.
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DEFECT DETECTION MODULE

he Defect Detection tool is designed to process voxel data sets for

internal defects and provides detailed analysis results with informa-

tion on each individual defect as well as overall statistical informa-
tion. A defect analysis report will be generated, containing information like
position, size, surface and volume of each individual defect.

Defect detection is an optional add-on module for VGStudlo MAX 2.0. It is
not available for myVGL. However, if a project contains an analysis, the
result of this analysis is available in myVGL.

If you are interested in more extensive functionality than the one offered by
myVGL, you have the chance to evaluate our other products, VGStudio 2.0 or
VGStudio MAX 2.0:

www.volumegraphics.com/products/evaluation/form. html
For further questions about our product portfolio, please contact
sales@volumegraphics.com

The defect detection dialog consists of several pages in which you can
inspect the defect detection analysis result. All pages share the button
Close.

® Close
Exits the dialog without performing an analysis. Parameter settings will be
saved. Reopen the analysis by double-clicking its entry in the Scene Tree.

A status bar at the bottom of each page signals the current status of the
analysis. The status can be one of the following:

® readytogo
Parameters are specified and consistent.

® analysis is up to date
The current analysis result is valid..

® analysis update required
Some user action led to an invalidation of the current analysis result.

® invalid parameter
At least one of the parameters has an invalid value. Check the parameters

or click Close.
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Settings

Tipsandtricks An invalid or not up-to-date status of an analysis is accentuated in the
Scene Tree with a warning sign. Double-click this analysis to open it and
check the status bar for messages.

Settings
Warning In myVGL, all grayed settings are displayed for informational value only.

Editing those settings or running the analysis is only possible using
VGStudio MAX 2.0 with the Defect detection module installed.

Preset Selection

Algorithm
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Select or remove a user defined preset from the preset selection pull down.
Any parameter set applied within the Settings page can be saved as a user
defined preset. Presets can be deleted, exported or imported via the respec-
tive buttons.

Select an algorithm from the pull down which the defect detection should
use for the analysis. Based on the selected algorithm the Calibration parame-
ters will differ.

The defect detection procedure consists of two steps.

* Check each voxel if it might be part of a defect or not. Create groups of
connected defect candidates.

* Check each group of defect candidates if it fits the parameters specified
by the user.

The following algorithms are available:

Only threshold
Every group of candidate defects matching the size specifications is con-
sidered a defect if the gray value is below the specified threshold.

Default
To allow for gray value variations, a more sophisticated approach is used,
thus also detecting defects, e.g., in dark areas.

Enhanced
This is a variation of the Default algorithm in a more fine-grained mode,
thus providing more sophisticated results but requiring more time.
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® Custom defect mask
The defect analysis is based on a region of interest (ROI). The ROI is sup-
posed to contain the defect candidates. To each voxel group of the ROI the
analysis parameters will be applied. Define the ROI manually, by import-
ing a ROI template or via a defect mask.

See the definition of the parameters for more detailed information on the
algorithms.

Calibration parameters
(This section is not available for the Custom defect mask algorithm; see
Defect mask selection on page 21 -4 for parameters applicable to this algo-
rithm instead).

® Threshold
(Only Threshold algorithm only)

Defect voxels are defined only by a gray value threshold. Threshold defines
the maximum defect gray value, every voxel with a gray value below
Threshold is considered as part of a defect.

® Defect Max

(Default and Enhanced algorithms only)

Seed voxels (defect candidates) are identified in an iterative manner. The
gray value of these seed voxels has to be below the Defect Max value.

® Background
(Default and Enhanced algorithms only)

Background is the lower limit of the interval for the iterations. Changing this
value has less significance than changing Defect Max or Runs.

® Runs
(Default and Enhanced algorithms only)

In Default algorithm, the number of the Runs determines the number of iter-
ations when determining and flooding a potential defect. High values will
lead to more reliable results at the cost of longer processing time.

In Enhanced algorithm, Runs determines the fineness when identifying seed
voxels. Flooding will be executed until a precision of one gray value is
reached.

® Use calibration
Click Use calibration to set Defect Max and Background values automatically
based on the calibration of the object. This mode is recommended for sin-
gle material objects and images with only a very low noise level.

Release 2.0 myVGL Manual 21-3



DEFECT DETECTION MODULE
Settings

Define manually

Click Define manually to specify background and material gray values by
sample areas. This procedure is similar to a calibration, but does not
(re-)calibrate the object. This mode is recommended for multi-material
objects and/or images with an average or above average noise level as it
allows you to select the sample areas specifically with regard to defects.

Defect mask selection

(This section is only available for the Custom defect mask algorithm; see
Calibration parameters on page 21-3 for parameters applicable to other
algorithms instead).

Custom defect mask
Choose the defect mask defining which voxels are part of defects and
which are not from the drop-down list.

Analysis parameters
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The analysis parameters influence the second stage of the defect detection
procedure.

Min. size | Max. size
Specified minimum and maximum defect size.

Due to the nature of CT data, the value for Min. size should be no less than 8
voxel edge lengths (i.e. an area of 2x2x2 voxels). Increase the value
decreasing data quality.

When specifying the Max. size of the defect, consider that longish cracks
have a rather large volume and that an accumulation of nearby very small
defects might be interpreted as one large defect. Specify the Max. size rather
generously.

Probability threshold

All potential defect areas passing the size check will be further processed
by several analysis stages. These stages try to differentiate between real
defects and artifacts by utilizing sophisticated image processing algo-
rithms. Each detected defect is tagged with a value indicating the probabil-
ity that it is a real defect. Specify the Probability threshold so that only defects
with a probability above the threshold will be included in the list.
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The figure below shows two defects with different Probabilities where the
left defect has a ten times higher Probability than the defect on the right
hand side.

® check neighborhood
If this option is enabled the defect detection algorithm compares the poten-
tial defect with its local neighborhood. If a potential defect‘s appearance is
very similar to the surrounding structure, its probability will be reduced.
This option is useful to reduce the number of erroneously detected artifacts.
The figure below illustrates the effect of this option: The image on the left
hand side has been obtained without, the one on the right hand side with
neighborhood check.

® ignore streak artifacts
Beam artifacts may appear within (industrial) CT data as linear dark
streaks. If Ignore streak artifacts is activated these structures are detected and
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assigned with a low defect probability value. See the figure below for an
example.

Wwarning A real defect might not be detected with ignore streak artifacts activated if it
is connected to and/or fits into the shape of a beam artifact.
A beam artifact might not be removed by the ignore streak artifacts algorithm
in cases where a beam artifact is connected to another defect so that the
total shape of both is no longer a straight line-like structure.

® ignore circular CT-artifacts
Circular artifacts may appear within (industrial) CT data as dark circles or
arcs. See the figure below for an example.

circular artifacts

center pixel

Activate ignore circular CT-artifacts to avoid an erroneous interpretation of
those circular structures as defects. A dialog will prompt you to draw a cir-
cle around such artifacts. Position the cross hair cursor within the center of
a circular artifact. All circular structures around this center (but not the cen-
ter itself) will be considered circular artifacts and will be discounted when
building the defects list.
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The center will not be visibly marked. To redefine it, deactivate and then
reactivate the option.

warning A real defect connected to a circular artifact will not be detected if ignore
circular CT-artifacts is activated.
A real defect with the shape of a circle (or a part of a circle) will not be
detected if the center of this circle would be the rotation center defined.

® ignore center CT-artifacts
The pixel in the rotation center may appear as a dark area within (indus-
trial) CT data. See the figure below for an example.

V

center pixel

h_

Activate ignore center CT-artifacts to avoid an erroneous interpretation of this
center pixel as defect. A dialog will prompt you to draw a circle around the
rotation center. Position the cross hair cursor within the center pixel.

warning A real defect connected to a center artifact will not be detected if ignore
center CT-artifacts is activated.
A real defect with a point-like shape will not be detected if it is positioned
in the rotation center defined.

Additional defect properties
The Defects table has columns for size (SizeX, SizeY, SizeZ) and projections
along one axis (PX, PY, PZ). These values will only be calculated if the cal-
culate size and projections checkbox is activated.

The projection values are the area of the defect projected flat along one of
the axes of the currently selected coordinate system (see Coordinate Sys-
tem in chapter Window menu on page 9-2).

See Defects on page 21-11 for further information on the columns of the
Defects table.
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Colors

Enable the defect size color coding checkbox to apply the color scheme
defined in the Colors page to the detected defects.

Warning

If this option is enabled the analysis requires more memory and needs more
time for the calculation.

LUT

Sections

Colors

By default, defects are marked in red in the CT data. Apply a color coding
scheme to mark defects depending on their size in different colors.

Preview how the detected defects are grouped according to size and
mapped to a specified color.

The Sections table defines intervals of defect sizes and assignes a color or a
color gradient to each interval. Define the size range of defects that are to
be colored by entering a minimum and maximum defect volume (From and
To, respectively).

The coloring can be based on a single size interval or a number of size
intervals. To create an interval, click Create smooth or Create stepped:

Create smooth
Generates one single color section. Clicking the button will show the Create
smooth table dialog.

Create stepped

Generates a set of color sections. Clicking the button will show the Create
stepped table dialog. Define the defect size range covered by the sections
and the step size.

Clicking Auto scale fits the LUT to the range of analysis results.

Warning

Clicking Create smooth or Create stepped will delete all sections in the table
and create new sections.

21-8 myVGL Manual

Each generated color section can be modified individually. In the Sections
table simply click onto an entry to modify its value.

From/ To
Define the start and end values of the color sections (size intervals).
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DEFECT DETECTION MODULE
Colors

Type

Switches between the coloring schemes Constant, Gradient, Rainbow and
Reverse Rainbow, thereby applying a single color or a multi-color scheme to
the selected interval.

Detalil

Modifies the appearance of the selected Type color scheme. Double-click to
open a dialog to select a color and/or specify color attributes (for the rain-
bow schemes, only the alpha channel can be modified).

split / merge

Right-clicking onto a color section produces a context menu with the
options split and merge. Splitting a color section divides it up into two new
color sections where each represents half of the original section. Merging
several color sections results into a single color section. Only consecutive
intervals can be merged.

Select an entry from the Defect opacity mode pull-down menu to specify the
opacity of a defect. Each defect consists of a voxel set. Each voxel has an
assigned intensity. Based on the intensity and the selected mode the defect
opacity is calculated. The following modes are available:

Ramp
The lower the defects intensity value the lower is its opacity value. The
higher the defects intensity value the higher is its opacity value.

Inverse ramp
The lower the defects intensity value the higher is its opacity value. The
higher the defects intensity value the lower is its opacity value.

Constant
Every defect is fully opaque independently of its intensity value.

Select a color from the Uncoded defect color chooser by double-clicking the
colored area with the left mouse button. A Select color dialog will appear in
which you choose the desired color.

This option only influences the color coding of the detected defects if you
did not enable the defect size color coding option on the Settings page (see
Process on page 21-8).

bar

If Auto tickmarks is enabled, equidistant tickmarks are produced for the color
bars. If Auto tickmarks is disabled, tickmarks appear only at the color section
boundaries.
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DEFECT DETECTION MODULE
General table features (Context Menus)

Select, remove, export or import a user defined preset from the preset selec-
tion pull down.

When saving a LUT, you can choose if you want to save an Absolute Preset,
i.e. a preset that maps colors to absolute defect size. If the checkbox is not
activated, colors are saved relative to the range of the analysis.

General table features (Context Menus)

Right click anywhere into the Defects or Annotations tables to show their
context menu. The menu contains the following options:

Columns
Here you toggle the visibility status of each column by enabling / disabling
the respective checkbox.

Save as default column layout

Any modifications applied to the table e.g. changing the sorting order of a
column, enabling / disabling of columns or changing the order in which
each column appears can be saved as default column layout. This layout
will be active until you selected Original column layout.

Original column layout
Restores the original table layout and discards any modifications applied
by the user.

Copy to clipboard
Copies the table into the clipboard.

Export as CSV ...
Exports the table values as CSV (Comma Separated Values) list.

Remove entries
Removes a complete row from the table

Create annotations
Creates annotations for the selected defects.

To change the order in which each column appears in the table press
<Ctrl> and left click the desired column header. Keep the <Ctr/> key
pressed and drag the mouse over the available column headers until the
new position is reached. Release the mouse button to insert the column at
its new position.
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Defects

The Defects table lists every defect detected by the defect detection analysis
module. By using the up and down cursor keys you step through the defects
table. Each defect is marked with a cross-hair cursor in each of the slice
views. You also can access any defect within the table by left-clicking on
it.

The individual columns within the Defects table are:

Analysis
The name of the analysis the defect belongs to.

Probability
The defects probability (see Analysis parameters on page 21-4).

Volume
The defect‘s volume.

Voxel
The amount of voxels the defect consists of.

PosX [ PosY | PosZ
The center position of the defect.

SizeX | SizeY I SizeZ
The size of the bounding box encapsulating the defect. See the figure
below for an illustration. These values will only be calculated if the appro-

T Z - axis

X - axis
< . )
- ~SZ
R SX

priate checkbox is activated (see Additional defect properties on
page 21-7).

Surface

The surface of the defect.

PXIPY|PZ
The surface area of the defect‘s shape projected along each of the axes of
the currently selected coordinate system (see Coordinate System in chapter
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DEFECT DETECTION MODULE
Defects

Window menu on page 9-2). See the figure below for an illustration. These

T Z - axis

X - axis

y - axis

values will only be calculated if the appropriate checkbox is activated (see
Additional defect properties on page 21-7)

Min
The minimum gray value within the defect.

Max
The maximum gray value within the defect.

Mean
The mean gray value within the defect.

Deviation
The gray value deviation within the defect.

Description
Enter a description for the component used for reporting.

Detail view

Select a view mode for reporting. Either choose one of the six view direc-
tions top, bottom, front, back, right or left or choose orthographic projec-
tion.

Detail zoom view
Select a zoomed Detail view for reporting.

Images

Displays the amount of images generated with the Capture from function.
Below the Components table is an area reserved for screenshots. To cap-
ture a screenshot first select a view from the pull down, then click the Cap-
ture from button. Each screenshot will be displayed in the area above. The
screenshots can be chosen to appear in the final report.You can specify a
name for the image by clicking the <no description> label twice.
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Defects

Material

DEFECT DETECTION MODULE
Statistics

Statistics

TR R R R R R N Y
You inspect various statistical data on this page. The page consists of a his-
togram showing the defect volume distribution within the voxel data set,
the Options area and the two sections Defects and Material.

In the Binning pull-down menu, you can choose between no binning and a
binning according to the sections of the color bar.

Furthermore, you can choose between Linear and Logarithmic scaling for
both axes in the Scale X and Scale Y pull-down menus.

The Defects section contains the following statistical values:

2 Voxel
The sum over all voxels contained within defects

> Volume
The sum over all defect volumes

> Surface
The sum over all defect surfaces

2 PX/PYIPZ
The sum over all projected defect surfaces

The Material section contains the following values:

Iso value

Specify an iso value which defines the material boundary of the to be ana-
lyzed voxel data set. This option is only available if your volume is not cal-
ibrated.

Volume
The volume of the to be analyzed voxel data set. It is either defined by an
Iso value, in case your object is not calibrated or by the calibration.

Defects
The sum over all defect volumes.

Porosity
The defect volume/(material volume + defect volume) ratio.
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Annotations

Annotations
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The Annotations table lists every annotation created for the selected defect
detection analysis. Here you can inspect information supplied by the anno-
tations or edit annotation properties.

To create an annotation select the desired defect detection analysis within
the Scene Tree and click the right mouse button to show the analysis con-
text menu. Select New > Analysis annotation and click into any 2D window or
the 3D window to position the annotation.

The annotation is designed as a movable label displaying informations
about the current analysis. A defect detection annotation contains the anno-
tation name, the defect‘s Volume (Vol), the defect‘s Probability (Prob) and the
position of the annotation.

The Volume value is color coded. The green color signalizes an available
Volume value for the current position. The yellow color signalizes that for
the current annotation position there is no Volume value available. This hap-
pens if the annotation is moved outside a defect.

To minimize/maximize the annotation double-click anywhere inside the
annotation.

Furthermore, you can arrange all annotations automatically by right-click-
ing within the respective window and choosing Annotations > Arrange.

The individual columns within the defect detection’s Annotations table are:

Analysis
The name of the analysis the annotation belongs to.

Name
The name of the annotation.

PosX / PosY | PosZ
Position of the annotation.

Volume
The volume of the defect at the given annotation position.

Description
Enter a description for the annotation used for reporting.

Image

Select a view mode for reporting. Either choose one of the six view direc-
tions top, bottom, front, back, right or left or choose orthographic projec-
tion.

Zoomed image
Select a zoomed Detail view for reporting.
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Capture images

Captures

Displays the amount of images generated with the Capture from function.
Below the Annotations table is an area reserved for screenshots. To capture
a screenshot first select a view from the pull down, then click the Capture
from button. Each screenshot will be displayed in the area above. The
screenshots can be chosen to appear in the final report You can specify a
name for the image by clicking the <no description> label twice.

Capture images

The Capture images page allows to take screenshot from the selected work-
space widget. The captured images are listed separately within the final
report apart from screenshots created in the Defects or Annotations section.

Report

The Report page lets you specify the content and the layout of the final
report. Either save the report as .rtf (Rich Text Format) or .html document
by clicking the Save button, or print it by clicking the Print button. The Print
button will show you a Print preview dialog. Use the Previous page and Next
page button to navigate through the report preview. Click the Layout button
to bring up the Print layout dialog. There you specify the orientation (Portrait
or Landscape), the paper size and the resolution.

Select which sections of the analysis should be included or excluded from
the report be either enabling or disabling the corresponding checkboxes
Settings, Defects, Statistics or Annotations.

Detail images settings

Logo

Cells

Use these settings to change the appearance of the detail images you speci-
fied in the Components and/or Annotations tables. Zoom factor sets the zoom
level for the Detail zoom view images in the respective tables. By enabling
the Manual check box you can change Color mode and or the Background color
of the various workspace widget screenshots created within the analysis.

Specify an image file that should be utilized as a logo within the report.

Each report page will contain a set of user defined cells. These cells are
part of the report layout and their content is customizable. Simply click on
a cell and select an attribute from the pull down. Either assign the attribute
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Report

to the Cell title or to the Cell content. The Cell title is a textual description of
the cell content. The Cell content defines what shall be displayed within the
cell. You can append attributes to previous attributes by clicking the assign
button again.
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he Wall Thickness Analysis tool processes a voxel data set for areas

within a user defined wall thickness interval (or, inversely, gap

width interval). As a result of such an analysis the user will get a
detailed report about the detected wall thickness and a miscolored data set
for documentation purposes.

Wall thickness analysis is an optional add-on module for VGStudlo MAX 2.0.
1t is not available for myVGL. However, if a project contains an analysis, the
result of this analysis is available in myVGL.

If you are interested in more extensive functionality than the one offered by
myVGL, you have the chance to evaluate our other products, VGStudio 2.0 or
VGStudio MAX 2.0:

www.volumegraphics.com/products/evaluation/form. html
For further questions about our product portfolio, please contact
sales@volumegraphics.com

The wall thickness dialog consists of several pages in which you can
inspect the wall thickness analysis result. Each page shares in its display a
Close button which closes the dialog.

A status bar at the bottom of each page signals the current status of the
analysis. The status can either be

* ready to go

Everything needed for the analysis is available.
* analysis is up to date

The current analysis result is valid.

* analysis update required

Modifying any Settings parameters will lead to an invalidation of the cur-
rent analysis result.

* object is not calibrated

No calibration information is available.
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Settings

Settings

Warning

In myVGL, all grayed settings are displayed for informational value only.
Editing those settings or running the analysis is only possible using
VGStudio MAX 2.0 with the Wall thickness module installed.

Preset Selection

Material

Wall thickness

22-2 myVGL Manual

Select or remove a user defined preset from the preset selection pull down.
Any parameter set applied within the Settings page can be saved as a user
defined preset.

If Use calibration is enabled, the analysis uses the calibration information to
determine the transition between background and material. This requires
the object to be calibrated before performing the analysis. If Use calibration
is disabled, an iso value has to be specified manually.

Under Analysis mode, you can specify if you want the algorithm to run on
the actual Material or on the Background. The latter option can be used deter-
mine the gap width of objects.

Use the Min. thickness and Max. thickness values to specify which wall thick-
ness interval you are interested in.

To measure meaningful distances, VGStudio MAX 2.0 searches the opposite
surface by sending a measurement line orthogonal to the current surface.
The surface area of the opposite surface is taken into account for the end
point of the measurement line is defined by a search cone. Search angle
specifies the search cone‘s aperture angle. See the figure below for an illus-
tration of this principle.

Object surfaces

Search angle
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Colors

Component analysis
The Min. volume value specifies the minimal size for a component to be
listed as a result.

In the Position property pull-down menu you can specify which part of a
component is to be it recognized as its position: the point of its Min. thick-
ness, Max. thickness or its Spatial center. This influences for example the val-
ues in the Pos X/Y/Z column of the Components table.

Algorithm details
By activating Create closed surface, additional boundaries are introduced.
For example if the analysis is performed within a region of interest (ROI)
and Closed surface is enabled, the ROI boundaries can be interpreted as
opposite surface. See the figure below for an illustration of this principle:
The image on the left hand side has been obtained using the Create closed
surface option, the image on the right hand side without this option.

Wall thickness [mm] :: 3 & — Wall thickness [mm]

Enabling the Advanced mode reduces the chance to get gaps in the analysis -
at the cost of significantly longer computing time.

When the High encoding precision option is enabled, the algorithm uses a
finer sampling rate which will produce more precise results at the cost of
significantly higher computing time. The resulting precision is displayed
below this option.

Colors

Define the color coding scheme used for the representation of the analysis
result mask.

LUT

The color lookup table (LUT) preview shows the partitioning into color
sections.
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WALL THICKNESS MODULE
Colors

In the Sections element the appearance of each color section is defined. Cre-
ate smooth will generate one color section. Clicking the button will show
the Create smooth table dialog. There the wall thickness range represented
by the respective section is defined.

Create stepped generates a set of color sections. Clicking the button will
show the Create stepped table dialog. Define the thickness range by entering
from and to values.

Clicking Auto scale fits the LUT to the range of analysis results.

Each generated color section can be modified individually. In the Sections
table simply click onto an entry to modify its value. From and To define the
start and end values of the color sections. Type switches between the color-
ing schemes Constant, Gradient, Rainbow and Reverse Rainbow. Detail lets you
modify the appearance of the selected Type color scheme. Right-clicking
onto a color section shows a context menu with the options split and merge.
Splitting a color section divides it up into two new color sections where
each represents half of the original section. Merging several color sections
results into a single color section. Only consecutive intervals can be
merged.

Show result lets you enable/disable the visual representation of your analysis
result. It does not modify the analysis result itself.

Select an entry from the Display mode pull-down menu to specify visual rep-
resentation of the analysis results. The following modes are available:

Ramp

The lower the gray value of the respective wall segment, the lower is its
opacity value. The higher the defects intensity value the higher is its opac-
ity value.

Inverse ramp

The lower the gray value of the respective wall segment the higher is its
opacity value. The higher the defects intensity value the lower is its opacity
value.

Constant
Every wall segment is fully opaque independently of its gray value.

Overlay

The color of the analyzed object will be set according to its local wall
thickness. This mode does not make sense if the analysis was run on the
Background of an object.
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General table features

Tickmarks on color bar

Preset selection

If Auto tickmarks is enabled, equidistant tick marks are produced for the
color bars. If Auto tickmarks is disabled, tick marks appear only at the color
section boundaries.

Select, remove, export or import a user defined preset from the preset selec-
tion pull down.

When saving a LUT, you can choose if you want to save an Absolute Preset,
i.e. a preset that maps colors to absolute wall thickness. If the checkbox is
not activated, colors are saved relative to the range of the analysis.

General table features

Right click anywhere into the Components or Annotations tables to show
their context menu. The menu contains the following options:

Columns
Here you toggle the visibility status of each column by enabling / disabling
the respective checkbox.

Save as default column layout

Any modifications applied to the table e.g. changing the sorting order of a
column, enabling / disabling of columns or changing the order in which
each column appears can be saved as default column layout. This layout
will be active until you selected Original column layout.

Original column layout
Restores the original table layout and discards any modifications applied
by the user.

Copy to clipboard
Copies the table into the clipboard.

Export as CSV ...
Exports the table values as CSV (Comma Separated Values) list.

Remove entries
Removes a complete row from the table

To change the order in which each column appears in the table press
<Ctrl> and left click the desired column header. Keep the <Ctr/> key
pressed and drag the mouse over the available column headers until the
new position is reached. Release the mouse button to insert the column at
its new position.
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Components

The Components table lists connected regions detected by the wall thickness
analysis.

Warning

Removing a Components entry will invalidate the current analysis. Click the
Update button to update the analysis.
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The individual columns within the Components table are:
* Analysis

The name of the analysis the component belongs to. If you select more than
one wall thickness analysis, the annotations of every wall thickness analy-
sis are listed. With the analysis information you can distinguish between
annotations belonging to different wall thickness analyses.

* Min thickness

The minimal thickness detected within the component.

* Max thickness

The maximum thickness detected within the component.
e PosX, PosY, PosZ

Depending on what has been chosen as Position property (see Component
analysis on page 22-3), this column lists the position of the Min. thickness,
Max. thickness or Spatial center of the respective component.

* Bottom (X, Y, Z) and Top (X, Y, Z)

The bottom and top values for each direction provide information about the
extent of an individual component.

* Volume

The volume of the component.

* Description

Enter a description for the component used for reporting.
* Images

Select a view mode for reporting. Either choose one of the six view direc-
tions top, bottom, front, back, right or left or choose orthographic projec-
tion.

* Zoomed image

Select a zoomed Detail view for reporting.
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* Captures

Displays the amount of images generated with the Capture from function.
Below the Components table is an area reserved for screenshots. To capture
a screenshot first select a view from the pull down, then click the Capture
from button. Each screenshot will be displayed in the area above. The
screenshots can be chosen to appear in the final report. You can specify a
name for the image by clicking the <no description> label twice.

Annotations

The Annotations table lists every annotation created for the selected wall
thickness analysis. Here you can inspect information supplied by the anno-
tations or edit annotations properties.

To create an annotation select the desired wall thickness analysis within the
Scene Tree and click the right mouse button to show the analysis context
menu. Select New > Analysis annotation, hold down <C# /> and click into
any 2D window or the 3D window to position the annotation.

The annotation is designed as a movable label displaying informations
about the current analysis. A wall thickness annotation contains the annota-
tion name, the current Thickness, the tolerance values specified via Min thick-
ness and Max thickness and the position of the annotation.

The Thickness value is color coded. The green color signalizes an available
Thickness value for the current position and the current tolerance values.
The yellow color signalizes that for the current annotation position there is
no Thickness value available. This happens if the annotation is moved out-
side the wall thickness result area. The yellow color can also mean that
within the chosen encoding precision (see Algorithm details on page 22-3) it
can not be decided if the annotation lies inside the specified tolerance inter-
val.The red color signalizes that the Thickness value at the current annota-
tion position is not inside the specified tolerance interval.

To minimize/maximize the annotation double-click anywhere inside the
annotation.

Furthermore, you can arrange all annotations automatically by right-click-
ing within the respective window and choosing Annotations > Arrange.

The individual columns within the wall thickness‘s Annotations table are:
* Analysis
The name of the analysis the annotation belongs to.

¢ Name
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Annotations

The name of the annotation.

* Pos(X,Y,Z)

Position of the annotation.

* Thickness

The thickness of the analyzed voxel set at the given annotation position.
* Enc. precision

This column is disabled per default and can be enabled via the context
menu. It displays the thickness interval for the respective component. The
displayed uncertainty results from the chosen encoding precision.

¢ Min thickness

By specifying Min thickness you introduce a tolerance value which states
that the thickness at the annotation‘s position must not be smaller than Min
thickness.

¢ Max thickness

By specifying Max thickness you introduce a tolerance value which states
that the thickness at the annotation‘s position must not be larger than Max
thickness.

* Description
Enter a description for the annotation used for reporting.
* Image

Select a view mode for reporting. Either choose one of the six view direc-
tions top, bottom, front, back, right or left or choose orthographic projec-
tion.

* Zoomed image
Select a zoomed Detail view for reporting.
* Captures

Displays the amount of images generated with the Capture from function.
Below the Annotations table is an area reserved for screenshots. To capture
a screenshot first select a view from the pull down, then click the Capture
from button. Each screenshot will be displayed in the area above. The
screenshots can be chosen to appear in the final report. You can specify a
name for the image by clicking the <no description> label twice.
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Capture images

Capture images
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The Capture images page allows to take screenshots from the selected work-
space widget. The captured images are listed separately within the final
report apart from screenshots created in the Components or Annotations sec-
tion.

Report

The Report page lets you specify the content and the layout of the final
report. Either save the report as .rtf (Rich Text Format) or .html document
by clicking the Save button, or print it by clicking the Print button. The Print
button will show you a Print preview dialog. Use the Previous page and Next
page button to navigate through the report preview. Click the Layout button
to bring up the Print layout dialog. There you specify the orientation (Portrait
or Landscape), the paper size and the resolution.

Select which sections of the analysis should be included or excluded from
the report be either enabling or disabling the corresponding checkboxes
Settings, Components or Annotations.

Detail images settings

Logo

Cells

Use these settings to change the appearance of the detail images you speci-
fied in the Components and/or Annotations tables. Zoom factor sets the zoom
level for the Detail zoom view images in the respective tables. By enabling
the Manual check box you can change Color mode and or the Background color
of the various workspace widget screenshots created within the analysis.

Specify an image file that should be utilized as a logo within the report.

Each report page will contain a set of user defined cells. These cells are
part of the report layout and their content is customizable. Simply click on
a cell and select an attribute from the pull down. Either assign the attribute
to the Cell title or to the Cell content. The Cell title is a textual description of
the cell content. The Cell content defines what shall be displayed within the
cell. You can append attributes to previous attributes by clicking the assign
button again.
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SHORTCUTS

T his chapter lists shortcuts used by myVGL2.0.

Shortcuts in 2D / 3D window

<Ctrl> + scroll wheel
Zoom to/away from position of the mouse pointer.

double-click middle mouse button
Switch between Rotate and Move mode.

Shortcuts in 2D window

scroll wheel
Scroll through slices.

hold middle mouse button + move mouse
Drag the slice around in the 2D window.

Shortcuts in 3D window

hold middle mouse button and move mouse up/down
In Move mode, this brings the camera closer to/farther away from the
object.

In Rotate mode, this rotates the object clockwise/counterclockwise.

<Ctrl> + move/rotate object
Move/rotate the object in fine steps.

<Shift> + move/rotate object
Move/rotate the object along the vertical or horizontal direction only.

double-click object
Select object (double-click into the background to deselect it)
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Shortcuts in Scene Tree

<Ctrl> + double-click object
Select/deselect multiple objects.

scroll wheel (if light source selected)
Modify intensity of selected light source.

Shortcuts in Scene Tree

double-click object
Open the properties dialog of the respective object, e.g. Render object prop-
erties dialog for a voxel object, parameter settings for an analysis.

Shortcuts for menu entries

<Ctrl> + N

New
<Ctrl>+ 0O

Open
<Ctrl> + Z

Undo
<Ctrl> +Y

Redo
<Del>

Delete

<CtrI> + <Shift> + R
Rotate

<Ctrl> + <Shift> + M

Move
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GLOSSARY

his chapter explains some of the terms used throughout the docu-
mentation and in the software. The explanations are tailored to the
usage of the respective term in the myVGL environment.

Cc

Coordinate system

myVGL uses right-handed, Cartesian coordinate systems to display data. The
orientation of each 2D or 3D window with respect to the currently chosen
coordinate system is indicated by the tripod in the lower left corner. To
align the slices seen in the 2D windows in different ways, you can choose
between several coordinate systems.

Comma separated values (.csv)
Files of the .csv format store tabular data using a comma to separate values.

E

N R R
Endianness

This specifies the byte order used to represent certain data. There are two
choices: big-endian and little-endian.

P

Partial Volume Effect
This describes the effect that due to the limited resolution of CT-scans,
properties of different materials can be merged within a single voxel. For
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example, if you zoom into an air-metal transition, you will see voxels with
intermediate gray values (see picture below).

metal

air

VGStudio MAX 2.0 uses these voxels of intermediate gray value to find the
surface of an object with sub-voxel precision.

Polygon

A polygon is a plane figure enclosed by straight line segments, for example
a triangle. In computer graphics, triangular polygons are used to model and
display surfaces of objects.

Preset

In myVGL2.0, you can save various sets of parameters as presets, for exam-
ple the settings made for a specific object in the Volume Rendering tool. You
can load these presets later to apply them to different objects or export
them to different computers.

R

Reference object

VGStudio MAX 2.0 ofters the following reference objects: points, lines, cir-
cles, planes, spheres, cylinders and cones. They are fitted to your data and
can be used to measure features of your data. Reference objects can also be
combined to measure for example the angle between two planes. Further-
more, you can use reference objects to register an object.

Registration

In some cases multiple data sets belong to one object, for example a
scanned object and its CAD model or partly overlapping sub-volumes of an
object too large to be scanned in one pass. The process of transforming
these different data sets into one coordinate system is called registration.
VGStudlo MAX 2.0 offers various algorithms to perform 3-D registration.

Rendering

The process of computing and displaying an image based on a model is
called rendering. The rendering process can include the application of
shadows, lighting, perspective and texture.
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FILE EXTENSIONS

T his chapter lists file extensions used by myVGL2.0.

Warning We strictly warn you against editing or deleting files in the project folder:
This can lead to inconsistencies and systems crashes or simply destroy your
project.

¢ .act
Denotes a color table file. Do not edit these files.

* lic
Denotes a license file. To activate the software, copy the license file into
the installation directory of myVGL. Do not edit, delete or otherwise modify
these files as this will invalidate your license.

* lut

Denotes a color table file. Do not edit these files.

® _pst
Denotes a preset file. Presets are available for various areas of the applica-
tion. Each preset combines parameters of a specific area. You can transfer
these files to another computer, but be warned that presets of the same
name will be overwritten on that computer. Do not edit these files.

° gl
Denotes a project file. Project files include references to all imported
objects, modifications such as rotation, opacity settings and analysis
results. Do not edit these files.

One .vgl files combines with a correspondingly named project folder to a
project. None is usable without the other.

° .vgp
Denotes a file that contains preview information that can be used by file
managers to create thumbnails. Do not edit or delete these files.

° .vgr
Denotes a file containing information about ROIs (references to a .vgm
file). Do not edit or delete these files.
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.vgs
Denotes a file containing information about polygons or point clouds. Do
not edit or delete these files.

.vgt
Denotes a measurement template file. Do not edit or delete these files.

.vgx
Denotes a CT-reconstruction parameter file. Do not edit or delete these

files.
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Symbols
avi 3-11

.bmp 3-10, 3-11
jp2 3-10,3-11
Jjpg 3-10, 3-11
.ppm 3-10, 3-11
stl 15-1

tif 3-10, 3-11
wvei 3-1

gl 3-1

Numerics
2D Windows 2-5
32 bit float 3-5
3D Window 2-2

A
absolute preset 11-1, 20-4, 21-10, 22-5
Activate Navigation Cursor 5-5
advanced calibration 6-2
algorithm
of defect detection 21-2
aligned clipping box 13-2
ambient 11-3, 15-4, 16-3
anaglyph image 17-2
Angle instrument 5-4
annotations 2-4, 2-8, 5-3
for defect detection 21-14
for nominal/actual comparison 20-6
for Wall Thickness Analysis 22-7
arrange 20-7,21-14, 22-7
attenuation
of light sources 16-4
auto
scale 20-3, 21-8,22-4
tickmarks 20-4, 21-9, 22-5
AVImovie 3-11

B

Background 9-2
Bitmap 3-10, 3-11
box 2-4

C
CAD 20-1

calculate projections 21-7
Calibration
advanced 6-2
Caliper instrument 5-5
camera
orientation 17-1
Camera tool 17-1
cells
of actual/nominal comparison report 20-8
of defect detection report 21-15
of wall thickness analysis report 22-9
center 14-2
check neighborhood 21-5
Circle 19-2
clamp
colors 20-4
outside distances 20-3
Clear undo queue 4-2
Clipping
box 13-2
objects 13-1
plane 13-1
tool 13-1
closed surface 22-3
CM Reporting 19-5
Color and Opacity mode 2-7, 9-3
Color mode 2-7,9-3
components (Volume Rendering presets) 11-1
Cone 19-2
constant
attenuation 16-5
context menu
of 2D window 2-7
of 3D window 2-4
Coordinate System 9-2
create closed surface 22-3
create smooth 20-3, 21-8, 22-4
create stepped 20-3, 21-8, 22-4
cull face 15-2
cumulated 20-5
cutoff Angle 16-5
Cylinder 19-2

D
data range mapping 3-5, 3-7
Defect detection module 21-1
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Defect opacity mode 21-9 Distance 5-3
defect size color coding 21-8 Indicator 5-3
Delete 4-2 Polyline 5-4
Deviation 20-5,21-12 interlaced 17-2
diffuse 11-4, 15-4, 16-3 intervals (of gray values) 11-3
directional 16-1 inverse ramp
Display for gray value import 3-6
distance 17-3 Volume Rendering preset 11-1
mode 9-3 inverse sawtooth 3-6
display mode 22-4 iso-level 11-5
Display unit 2-10 Isosurface renderer 11-5
Distance instrument 5-3 isosurface transparent 11-2
E J
Export JPEG images 3-10, 3-11
preset 11-1,15-1, 16-1 JPEG2000 images 3-10, 3-11
eye distance 17-3
L
F left image only 17-2
file types 3-1 Level/Window mode 9-3
focal light sources 16-1
depth 17-3 directional 16-1
point 17-1 point 16-2
force isotropic resampling 3-4 spot 16-2
Light tool 16-1
G line 19-1
gap width 22-2 Local
gradient Snap mode 5-6
attenuation, 16-5 lock
snap mode 5-6 slice position 2-6
gray value 3-5 logo 18-3, 20-8, 21-15, 22-9
histogram 11-2 lookup table 22-3
intervals 11-3 LUT 20-2,21-8,22-3
H M
Hardware renderer (Scatter HQ) 11-6 material face settings 15-4
high encoding precision 22-3 Max
histogram distance 20-2, 20-3
in Import dialog 3-7 Snap mode 5-6
of nominal/actual comparison 20-4 thickness 22-6, 22-7
Maximum Projection 11-6
| Min
icon bars 2-9 S‘?ap mode 5-6
ignore . thickness 22-6, 22-7
center CT-artifacts (in defect detection) 21-7 min/ max
circular CT-artifacts (in defect detection) 21-6 o size of defects 21-4
streak artifacts (in defect detection) 21-5 mirror
axes 3-7

image stack 3-1
Move mode 2-3, 13-2

Import

Polygon 3-9

preset 11-1,15-1, 16-1 N
Indicator instrument 5-3 Navigation Cursor 5-5
Instruments 5-1 Nearest

Angle 5-4 Snap mode 5-6

Caliper 5-5 No slice interpolation beyond... 3-4
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Normalize gradients 11-7

(o)

opacity 11-4

manipulation area 11-2
opacity transfer function 11-2
OpenGL 17-3
Original display mode 2-7, 9-3
overlays 3-10
override resolution 3-4, 14-2
oversampling 11-7

P
parallel 17-2
partial volume effect 3-8
percentage 20-5
perspective 17-2
Phong 11-5
point 16-2, 19-1
Polygon Rendering tool 15-1
Polyline instrument 5-4
Portable Pixmap 3-10, 3-11
position 14-1
Pplane 19-2
Preferences 4-2
preset 2-5,2-8, 11-1, 15-1, 16-1, 18-1, 20-2, 20-4, 21-2,
21-10, 22-2, 22-5, 24-2, 25-1
preview
in Import dialog 3-8
reduction factor 2-3
Print
image(s)... 3-11
layout 20-8, 21-15, 22-9
preview 20-8, 21-15,22-9
probability 21-14
threshold 21-4
project files 3-1
projection
mode 17-2
parallel 17-2
perspective 17-2

stereo-perspective 17-2
properties
of reference objects 19-3

Q

Quad 9-2

R
rainbow 20-3, 21-9, 22-4
ramp 3-6
Volume Rendering preset 11-1
Redo 4-1
reference
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INDEX

object 24-2
Region of Interest
See ROI
Render
point cloud 15-3
solid 15-2
wireframe 15-2
report
of defect detection 21-15
of nominal/actual comparison 20-8
of wall thickness analysis 22-9
resolution 14-2
reverse
rainbow 20-3,21-9, 22-4
rgb8 3-5
right image only 17-3
ROI 3-6
Rotate mode 2-3, 13-1
rotation 14-1
Ruler 9-2

S

Save
AVI/image stack ... 3-10
image(s)... 3-9
sawtooth 3-6
Scatter (v1.2) 11-6
Scatter Gradient (v1.2) 11-6
Scatter HQ
Hardware Renderer 11-6
Volume Renderer 11-5
Scatter HQ (v1.2) 11-6
scene 3-1
zoom 17-3
Selection
of objects 2-2
shadows 16-1, 16-4
shared color 11-4
shininess 11-4, 15-4
show result 22-4
signed
16 bit 3-5
32 bit 3-5
8 bit 3-5
skip 3-7
X/Y/Z 20-2
Slice step width 9-3
Slices Left/Right/Below 9-2
Snap 5-6
specular 11-4, 15-4,16-3
Sphere 19-2
spot 16-2
Stereolithography
ASCII File Format 15-1
Binary File Format 3-9, 15-1
File Format 15-1
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stereo-perspective 17-2 X
Sum along Ray 11-6 X-Ray 11-6
swap 11-5

axes 3-7

distance signs 20-2

-

text labels 18-2
Text Overlay Editor 18-1
thickness 22-2, 22-7
tickmarks on color bar 20-4, 21-9, 22-5
Tiff images 3-10, 3-11
toggle
transform mode 2-7
tolerance 20-7
tooldocks 2-9
Tools menu 8-1
Transformation
tool 14-1
transparency 11-4
tripod 2-4
type
point count 20-4
surface 20-4

U
uncoded defect color 21-9
Undo 4-1

Clear undo queue 4-2
unit 2-10
unsigned

16 bit 3-5

32 bit 3-5

8 bit 3-5
up vector 17-1

Vv

variance 20-7

view Angle 17-2

volume 21-14

Volume renderer (Phong) 11-5

Volume renderer (Scatter HQ) 11-5

Volume Rendering presets
components 11-1
inverse ramp 11-1
isosurface transparent 11-2
ramp 11-1

Volume Rendering tool 11-1

W

Wall thickness module 22-1
Window menu 9-1
workspace 2-1
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